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1. 概要 
1.1. ADVENTURE_BCtoolの位置づけ 

ADVENTURE_BCtool は与えられたメッシュに境界条件、材料物性値、及び多点拘束

(MPC)条件を貼付け、ADVENTURE_Thermal、ADVENTURE_SolidおよびMPC条件を

考慮できるソルバのための有限要素解析データを作成するツールです。 

図 1.1-1 に BCtool と ADVENTURE の他のモジュールとのデータ依存関係を示します。 

 

 

  

1.2. 機能 

BCtool は以下の機能を提供します。 

 

 境界条件設定機能 

 動解析のための初期条件設定機能 

 境界条件設定のための表面パッチ作成機能 

 MPC (多点拘束)条件設定機能 

 物性値設定機能 

 MPC 及び物性値設定のためのボリューム表面パッチ作成機能 

 メッシュ・境界条件・物性値を 1 つの一体型 ADV ファイルに変換する機能 

 設定された MPC 条件を ADV ファイルに変換する機能 

 

 

 

 

 

図 1.1-1 BCtoolと ADVENTUREの他のモジュールとの関係 
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以下のデータに対応しています。 

対応している要素の種類 

 4 面体 1 次要素、4 面体 2 次要素、6 面体 1 次要素、6 面体 2 次要素 

対応している解析の種類 

 弾性解析 

 弾塑性解析 

 熱応力解析 

 動的応力解析 

熱伝導解析 

 熱流体解析 

 電磁界解析 (境界条件設定のみ) 

境界条件を設定できる場所 

 グループ化したメッシュ表面 

 グループ化したメッシュ表面の境界上の 1 次節点 

設定できる境界条件 

 変位（X,Y,Z 方向、面に垂直方向） 

 速度（X,Y,Z 方向） 

 加速度（X,Y,Z 方向） 

 荷重（X,Y,Z 方向、面に垂直方向） 

 圧力 

 温度 

 熱流束 

 熱伝達 

 熱ふく射 

 磁場ベクトルポテンシャル 

設定できる MPC条件 

 固着  

 剛体はり 5種 

 単純はり 

 線形結合式 

設定できる初期条件 

 初期温度 

設定できる物性値（複数物性値に対応） 

 ヤング率 

 ポアソン比 

 加工硬化係数 

 初期降伏応力 

 質量密度 

 線膨張係数 

 参照温度 

設定できる解析条件 

 重力加速度 
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1.3. 動作環境 

1.3.1. BcGUI2 

BcGUI2 については、 

 Ubuntu 14.04 LTS (64bit) 

 Microsoft Windows 10 Home (64bit) 

で動作確認を行っています。 

 

1.3.2. BcGUI2以外 

BcGUI2 以外のコマンドについては、 

 Ubuntu 14.04 LTS(64bit) 

 Make GNU Make  

 コンパイラ GCC 4.8 

 Perl 5.10.1 

 Java8 (Oracle JDK もしくは OpenJDK) 

で動作確認を行っています。 

 

1.4. インストール方法 

1.4.1. BcGUI2 

BcGUI2 はコンパイル不要のバイナリパッケージとして配布しています。 

バイナリパッケージのインストールは、64 ビット Windows では AdvBcGUI-2.1-bin-

windows_x64.zip を、 32 ビット Windows では AdvBcGUI-2.1-bin-windows_x86.zip、を、

Linux では AdvBcGUI-2.1-bin-linux.tar,gz をそれぞれ展開します。展開すると

AdvBcGUI-2.1 というフォルダが作成されます。作成されたフォルダは任意の場所に移動

し て い た だ い て か ま い ま せ ん 。 ま た 、 Linux 版 で は install.sh を 実 行 し 、

${HOME}/ADVENTURE へのインストールを行います。 

 

1.4.2. BcGUI2以外 

1.4.2.1. ADVENTURE_IOライブラリのインストール 

ADVENTURE_IO のライブラリをインストールします。詳細は ADVENTURE_IO のマ

ニュアルをご覧ください。 

 

1.4.2.2. Makefileの編集 

AdvBCtool-2.1/Makefile を、各自の環境に合わせて修正します。 

初期状態では、他の ADVENTURE のモジュールを${HOME}/ADVENTURE にインス

トールした状態に合わせてありますので、他の場所にインストールした場合のみ修正を行

ってください。修正する場合は、以下の 2 行を書き換えます 

ADVIO_PREFIX=(ADV_IO がインストールされている場所) 

PREFIX=(ADV_BCtool をインストールしたい場所) 

 

1.4.2.3. コンパイル 

以下の手順で実行します。 
% make 

 

1.4.2.4. インストール 

以下の手順で実行します。 
% make install 

すべてのツール、スクリプト、ドキュメントがインストールディレクトリにコピーされ

ます。 
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2. 構造解析 
2.1. データフロー 

構造解析における BCtool の使用方法は大別して次の 2 種類があります。 

(1) 拘束及び荷重の構造解析用境界条件(今後通常の構造解析境界条件と呼びます)を

有するデータの作成 

(2) 複数のボリューム間の MPC 条件と通常の境界条件を持つ構造解析用データの作

成 

第一の使用方法の場合のデータフローを図 2.1-1 に示します。第一の使用方法では、

msh2pch、BcGUI 及び makefem3(内部で a2adv を呼ぶ)を使用します。動的解析の場合に

は、時刻歴データを作成するために、csv2advも使用します。第二の方法のうちMPC条件

設定方法は二つに分かれます。一つは接触する複数のボリューム間に自動的に固着のMPC

条件を生成する場合で、MpcMasterSlaveTool というツールを使います。ツール

MpcMasterSlaveTool は、MPC_mshmrg.pl と MPC_assem2 という二つのコマンドから

構成されます。この方法についてのデータフローを図 2.1-2 に示します。もう一つは複数

のボリューム間に各種の MPC 条件を生成する場合で、BcGUI の対話処理と

MpcLocal2Global を併用することにより、手動で MPC 条件を生成する場合です。この方

法についてのデータフローを図 2.1-3 に示します。 

 

 

図 2.1-1通常の境界条件設定時のデータフロー図 
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図 2.1-2 MpcMasterSlaveTool使用時のデータフロー図 

図 2.1-3 MpcLocal2Global使用時のデータフロー図 
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ADVENTURE_BCtool を使ってメッシュに境界条件、物性値を貼り付けるためには 

(1) メッシュの表面の抽出 

(2) BcGUI による境界条件の設定（物性値の設定を含む） 

(3) Solid 用一体型入力ファイルの作成 

(4) 時刻歴データの追加・・・動解析のみ 

(5) MPC の設定・・・MPC 使用者のみ 

の 5ステップの手順を踏みます。 

 

2.2. メッシュの表面の抽出 

msh2pch コマンドを使用して、メッシュの表面を抽出およびグループ化し、BcGUI の

入力フォーマットへ変換します。このステップでの入力ファイル、出力ファイルは以下の

とおりです。 

入力ファイル： 

 メッシュデータファイル    （拡張子は msh） 

出力ファイル： 

 メッシュ表面データファイル   （拡張子は fgr） 

 表面メッシュ抽出データファイル   （拡張子は pch） 

 表面パッチグループ(以下面グループ)データファイル （拡張子は pcg） 

 グローバルインデックスファイル   （拡張子は trn） 

 

msh2pch にはコマンドライン引数が２つあります。 

 
% msh2pch mshFile div_n 

 mshFile 

メッシュデータファイル名。シングルボリューム、マルチボリュームいずれも

利用可能です。 

 div_n 

メッシュ表面のグループ化の基準となる 2 面挟角の指定。2 面挟角が指定した

角度以上の面は別のグループになる。90 度の何分の１かで指定する。 

 

例-1）メッシュデータファイル名が Model.msh、2 面挟角が 30 度（=90/3) 

 % msh2pch Model.msh 3 

例-2）メッシュデータファイル名が Model.msh、2 面挟角が 45 度（=90/2） 

 % msh2pch Model.msh 2 

 

2 面挟角を何度に指定するのが適当かはモデルによって異なります。グループ化が粗す

ぎるか、細かすぎるかは BcGUI での表示を見て、ユーザーが判断します。 

メッシュデータファイル名が Model.msh、2 面挟角が 90/N 度の場合、 

出力ファイル名は以下のようになります。 

 Model_N.fgr :メッシュ表面データファイル 

 Model_N.pch :表面メッシュ抽出データファイル 

 Model_N.pcg :面グループデータファイル 

 Model_N.trn :グローバルインデックスファイル 
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2.3. 境界条件の設定 

境界条件の設定には、GUI ベースのツールである BcGUI2 を使用します。このステップ

での入力ファイル、出力ファイルは以下のとおりです。 

入力ファイル： 

 表面メッシュ抽出データファイル   (拡張子 pch) 

 面グループデータファイル   (拡張子 pcg) 

出力ファイル： 

 解析条件ファイル    (拡張子 cnd) 

 

2.3.1. BcGUI2の起動 

2.3.1.1. コマンドラインによる起動 

以下のようにBcGUIのコマンドライン引数を指定して起動することが可能です。境界条

件もしくは MPC 条件を設定するときの起動方法は、次のようになります。 
% BcGUI2 pchFile pcgFile [-icnd cndFile] [-ocnd outFile] 

 pchFile :表面メッシュ抽出データファイル名(シングルボリューム) 

 pcgFile :面グループデータファイル名 

 cndFile :起動時に自動的に読み込む解析条件ファイル名 

 outFile :終了時に自動的に書き込む解析条件ファイル名 

[…]は省略可能です。 

-icnd オプションを指定すると、あらかじめ作成しておいた解析条件ファイルを起動 

時に自動的に読み込むことができます。 

-ocnd オプションを指定することにより、BcGUI の終了時に自動的に解析条件ファ 

イルを出力させることができます。 

 

また、物性値の設定を行うときの起動方法は、次のようになります。 
% BcGUI2 pcmFile pcgFile 

 pcmFile :表面メッシュ抽出データファイル名(マルチボリューム) 

 pcgFile :面グループデータファイル名 

 

2.3.1.2. BcGUI起動後にファイルを指定する方法 

BcGUI を起動した後でファイルを指定する方法もあります。インストールフォルダにあ

る BcGUI2.bat(Windows)または BcGUI2(Linux)を実行してください。 

BcGUI を実行すると図 2.3-1のような画面が起動します。 

図 2.3-1起動直後の画面 
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メニューで”File” > “Open File”を選択します。図 2.3-2 のダイアログが表示されます。 

 

 
図 2.3-2 pch/pcg ファイル指定ダイアログ 

 

上の方の”Select”では、通常のシングルボリュームを扱う場合は pch ファイルを、MPC

条件および物性値の設定を行うとき等マルチボリュームを扱う場合は pcm ファイルを選択

します。一方下の方の”Select”では、上で選択した pch/pcm ファイルに対応する pcg ファ

イルを選択します。図 2.3-3 に上で pch ファイル(case5-quadratic_4.pch)を、下で pcg フ

ァイル(case5-quadratic_4.pcg)を選択した場合の例を示します。 

 

 
図 2.3-3 pch/pcg を選択した後 

 

“OK”ボタンをクリックしますと、モデルが読み込まれて、元の画面が図 2.3-4 のように

なります。 

 

 

図 2.3-4 case5-quadratic_4 を表示した様子 

 

2.3.1.3. ヒープメモリの最大値の修正 

表示する pch/pcg モデルファイルの規模によっては、メモリ確保に失敗してプログラム

が反応しなくなることがあります。その場合、本プログラムのログが見られるようになっ

ていれば、最終行に 
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java.lang.OutOfMemoryError 

と表示されます。そのときは BcBUI2.bat (Windows)もしくは BcGUI2 (Linux)をテキスト

エディタで開き、以下の設定を java コマンドのオプションに追加して、ヒープメモリの初

期値と最大値を増加して下さい。初期状態ではヒープメモリの最大値を 1GB に設定してい 

に設定しています。 以下に、ヒープメモリの初期値を 1GB、最大値を 4GB に設定する場

合の例を示します。 

 

修正前 : java -Xmx1000M -cp [以下略] 

修正後 : java -Xms1000M -Xmx4000M -cp [以下略] 

 

2.3.2. マウスによる視線移動方法 

平行移動 マウス左ボタンを押下+ドラグ。 

回転  マウスホイールボタンを押下+ドラグ。 

ズームイン マウス右ボタンを押下+下向きにドラグ。 

ズームアウト マウス右ボタンを押下+上向きにドラグ。 

2.3.3. 表面一次節点、面グループの選択方法 

 節点の選択 

左ボタンで節点をクリック(ピック)します。 

 面グループの選択 

一旦節点をピックした後、右ボタンをクリックすると、その節点が所属する面グ

ループが順次選択されます。一周すると元の節点の表示に戻ります。 

 面内の節点の選択 

MPC 条件設定の時のみ、面内の節点をピック出来ます。一旦面グループを赤色

表示した後、面グループ内の節点を左クリックします。 

 

ピックしたオブジェクトは黄色で表示されます (MPC 条件の場合は赤色です)。 

オフジェクトのピックとメニュー操作の順序ですが、先に節点または面グループをピッ

クしてから、境界条件用のメニューを選択することになります。ピックすると、選択中の

節点の(pch での)情報または面グループの(pcg での)情報が画面下のステータスバーに表示

されます。 

ピックの解除は ESC キーで可能です。節点の場合は、選択済みの節点をもう一度ピック

すると選択が解除されます 

MPC 条件のピックはメニューで MPC 条件用のメニュー項目を選択し、ダイアログが開

かれた後に初めて可能になります。 

(MPC 条件のピックを解除する場合は、ダイアログの中の"Clear"ボタンをクリックする

と解除されます。 
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2.3.4. 境界条件の設定方法(面グループに対する拘束) 

図 2.3-5 に示すように、拘束したい面グループを囲むエッジ上の節点をどれか一つピッ

クします。 

 

 
図 2.3-5 節点の選択 

 

次に右クリックを 2 回して、拘束したい端部の面をハイライトします(図 2.3-6)。右クリ

ックの回数は同じ点であっても毎回同じとは限りません。 

 

 
図 2.3-6 拘束する端部の面をハイライトした様子 
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その状態で、メニューから"BC" > ”BC(Solid)” > "Add Displacement"を選択すると、図 

2.3-7 のダイアログが表示されます。 

 

 
図 2.3-7 拘束指定用のダイアログ(設定前) 

 

拘束したい方向をチェックします(例えば図 2.3-8)。数値を入力すると強制変位を指定す

ることが出来ます。”Transient Table ID”とは 2.6 節で用意する、時刻履歴データ表の ID

のことです。2.6 節では時刻歴 ID と呼んでいます。これは境界条件を時刻歴で与える場合

のみ使用します。自由度毎に異なる IDを指定することが可能です。各チェックボックスを

チェック後、”Transient Table ID”入力フィールドに数値を入力すると時刻歴 ID の指定が

有効になります。何も入力しなかった場合、有効になりません。設定できる値は時刻履歴

データ表に用意された ID のみです。 

 

 
図 2.3-8 拘束設定用ダイアログ(設定後) 

 

設定後"OK"ボタンをクリックします。 
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2.3.5. 境界条件の確認方法(拘束条件を付加した面グループの確認) 

面グループの選択を解除してから、メニューで"View" > "Boundary Condition" > "View 

Displacement"を選択します。図 2.3-9 のように緑色で拘束を付加した面グループがハイラ

イトされます。 

 
図 2.3-9 面グループに設定した拘束条件を表示している様子 

 

拘束条件の表示を解除するには、メニューで"View" > "Boundary Condition" > "None"を選

択して下さい。 

 

2.3.6. 境界条件の設定方法(節点に対する拘束) 

図 2.3-10 に示すように、拘束したい節点をどれか一つピックします。 

 
図 2.3-10 拘束したい節点を選択した様子 
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その状態で、メニューから"BC"> ”BC(Solid)” > "Add Displacement"を選択しますと拘

束設定ダイアログが表示されます。 

設定方法・項目は 2.3.4 節で示した面グループに対しての拘束設定と同じです。数値を

入力した後のダイアログを図 2.3-11 に示します。 

 

 
図 2.3-11 拘束設定用ダイアログ(設定後) 

 

2.3.7. 境界条件の確認方法(拘束条件を付加した節点の確認) 

節点の選択を解除してから、メニューで "View" > "Boundary Condition" > "View 

Displacement"を選択します。図 2.3-12 のように拘束を付加した節点上にベクトル表示さ

れます。 

 

 
図 2.3-12 可視化した節点上の拘束条件 
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2.3.8. 境界条件の設定方法(面グループに対する荷重) 

図 2.3-13 に示すように、荷重を負荷したい面グループを囲むエッジ上の節点をどれか一

つピックします。 

 

 
図 2.3-13 エッジ上の節点を一つ選択 

 

引き続き、右クリックして端部の面グループを選択します(図 2.3-14)。 

 

 
図 2.3-14 荷重を負荷する端部の面グループを選択した様子 
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引き続き、メニューで、"BC" > ”BC(Solid)” > "Add SurfaceTraction"を選択しますと図 

2.3-15 のように荷重設定ダイアログが表示されます。 

 
図 2.3-15 荷重設定ダイアログ(設定前) 

 

荷重を負荷したい方向をチェックして、右の欄に荷重値を入力します。荷重の次元は面

積で割ったものですので、ご注意下さい。図 2.3-16 に荷重設定例を示します。 

 
図 2.3-16 荷重設定ダイアログ(設定後) 

 

2.3.9. 境界条件の確認方法(荷重条件を付加した面グループの確認) 

面グループの選択を解除してから、メニューで"View" > "Boundary Condition" > "View 

SurfaceTraction"を選択します。図 2.3-17 のように荷重を負荷した面グループが赤紫色でハ

イライトされます。 

 
図 2.3-17 面グループに設定した荷重条件を表示している様子 
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2.3.10. 境界条件の設定方法(節点に対する荷重) 

図 2.3-18 に示すように、荷重を負荷したい節点をどれか一つピックします。 

 

 
図 2.3-18 荷重を負荷したい節点を選択した様子 

 

引き続き、メニューで、"BC" > ”BC(Solid)” > "Add PointLoad"を選択しますと荷重設定ダ

イアログが表示されます。 

設定方法・項目は 2.3.8 で示した面グループに対しての荷重設定と同じです。数値を入

力した後のダイアログを図 2.3-19 に示します。 

 

 
図 2.3-19 荷重設定用ダイアログ(設定後) 
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2.3.11. 境界条件の確認方法(荷重条件を付加した節点の確認) 

節点の選択を解除してから、メニューで"View" > "Boundary Condition" > "View PointLoad"

を選択します。図 2.3-20 のように荷重を付加した節点上にベクトル表示されます。 

 
図 2.3-20 可視化した節点上の荷重条件 

 

 

2.3.12. 重力加速度の設定方法 

メニューで"BC" > "Gravity Acceleration" を選択します。図 2.3-21 に示すダイアログが表

示されます。 

 
図 2.3-21 重力加速度設定ダイアログ(入力前) 

 

重力加速度ベクトルの各成分を入力して下さい。例えば図 2.3-22 のようになります。そ

して"OK"ボタンをクリックします。 

 
図 2.3-22 重力加速度設定ダイアログ(入力後) 
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2.3.13. その他の境界条件設定 

節点に対し"BC" > “BC(Solid)” > “Add PointLoad(Nonlinear)”より静的非線形解析時の荷重

履歴テーブルが、時間履歴 ID を用いて与えられます。 

節点、面グループに対し"BC" > “BC(Solid)” > “Add Displacement(Nonlinear)”より静的非線

形解析時の強制変位履歴テーブルが、時間履歴 ID を用いて与えられます。 

節点、面グループに対し"BC" > “BC(Solid)” > “Add InitialVelocity”より初期速度が与えら

れます。 

節点、面グループに対し"BC" > “BC(Solid)” > "Add Velocity"より、速度が与えられます。 

節点、面グループに対し"BC" > “BC(Solid)” > "Add Acceleration"より加速度が与えられま

す。 

面グループに対し"BC" > “BC(Solid)” > "Add Pressure"より圧力が与えられます。 

面グループに対し"BC" > “BC(Solid)” > “Add SurfaceTraction(Nonlinear)”より静的非線形解

析時の荷重履歴テーブルが、時間履歴 ID を用いて与えられます。 

設定方法は今までのものと同様です。 

 

2.3.14. 境界条件のクリア 

先ず図 2.3-23 のステータスバーに示すように、面グループ番号 11 に、Z 軸方向に 1.0の

荷重を負荷しておいてから“BC” > "BC(Solid)" > "Clear SurfaceTraction"を選択します。 

 
図 2.3-23 面グループ 11 に負荷した荷重条件をステータスバーに表示 

 

すると図 2.3-24 のダイアログで、念を押してきますので良ければ"了解"をクリックして

下さい。 

 
図 2.3-24 荷重条件消去の確認ダイアログ 

 

再度面グループ 11 を選択すると、図 2.3-25 のように、ステータスバーからは、荷重条
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件の表示が消えております。もし同じ種類の条件を複数設定していれば、それら全てが削

除されます。 

 
図 2.3-25 面グループ 11 に関する荷重条件が消去された様子 

 

"BC” > “BC(Solid)" > "Clear PointLoad"  

表面力のときと同様です。 

 

"BC” > “BC(Solid)" > "Clear Displacement"  

表面力のときと同様です。 

 

"BC” > “BC(Solid)" > "Clear Velocity"  

表面力のときと同様です。 

 

"BC” > “BC(Solid)" > "Clear Acceleration"  

表面力のときと同様です。 

 

"BC” > “BC(Solid)" > "Clear Pressure"  

表面力のときと同様です。 

 

2.3.15. 既に設定した拘束や荷重の内容確認や修正 

既に条件を設定した面グループや節点を選択してから、メニューで"BC" > “BC(Solid)” > 

"Add Displacement"や"BC" > “BC(Thermal)” > "Add SurfaceTraction"を選択すると、表示され

るダイアログに既に設定した条件の内容が表示されます。そのダイアログで設定を変更し

て、"OK"ボタンをクリックすると、設定が上書き修正されます。 

また”View” > “Boundary Condition” > “Cnd format”から、現在設定されている境界条件のリ

ストを見ることができます。 
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2.3.16. 境界条件の保存 

起動時に-ocnd オプションを指定したときは、この操作は不要です。 

メニューで"File" > "Save Condition"を選択して、表示されるファイル選択ダイアログで保

存するファイル名を入力して保存してください。拡張子の cnd は抜けていれば自動的に補

われます。既存のファイルを指定すると警告が表示されます。 

保存したファイルの内容をリスト 2.3-1 に示します。尚、この操作により、本プログラ

ム起動以後に設定した全ての境界条件が保存されます。 

 

リスト 2.3-1 保存した境界条件設定ファイル(*.cnd)の内容 
gravity 0.0 0.0 0.0 

boundary 4 

tracOnFaceGroup 11 0 2 -1.0 

Transient 1 dispOnFaceGroup 0 0 0 0.0 

Transient 1 dispOnFaceGroup 0 0 1 0.0 

Transient 1 dispOnFaceGroup 0 0 2 0.0 

cnd ファイルのフォーマットについては 9.10 章を参照して下さい。 

 

2.4. 物性値の設定 

材料物性データを作成します。サンプルファイルとしてはインストールフォルダの下の、

samples フォルダにある multiBrick_V.pcm/multiBrick_V.pcg を用います。 

 

2.4.1. ボリューム表面の抽出 

msh2pcm コマンドを使用して、メッシュからボリューム表面を抽出およびグループ化

し、BcGUI の入力フォーマットへ変換します。 

msh2pcm は、以下のように実行します。 
% msh2pcm mshFile 

 mshFile:  メッシュデータファイル名。 

 

メッシュデータファイル名が Model.mshの場合、出力ファイル名は以下のようになりま

す。 

 Model_V.pcm: 表面パッチデータファイル 

 Model_V.pcg: 表面パッチグループデータファイル 

 

2.4.2. ボリュームの表示 

次に、ボリュームを表示するために、BcGUI 2 を起動しファイルを読み込みます。 

コマンドライン経由で、引数にファイル名を与えて起動する方法と、ショートカット経

由で起動しメニューの“File” > “Open File”を選択してファイルを読み込む方法と 2 通りの方

法があります。メニュー経由でファイルを読み込む方法については、2.3.1.2 をご覧くださ

い。 

コマンドライン引数にファイル名を与えて起動する場合は以下のように実行します。 
% BcGUI2 pcmFile pcgFile 

  pcmFile:  表面パッチデータファイル名 

 pcgFile:  表面パッチグループデータファイル名 

 

BcGUI2 は第一引数の拡張子が pcm である場合には、ボリューム表示モードで起動しま

す(図 2.4.1-1)。 
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図 2.4.1-1 ボリューム表示モード 

 

ボリューム表示モードでは、節点のクリックや境界条件の設定は行えません。 

キーボードの n、p を押下することによりボリュームを順次選択できます。n を押下する

とボリューム番号が増加し、p を押下するとボリューム番号が減少します。選択されてい

るボリューム番号は、画面左上に表示されます(図 2.4.1-2)。 

 
図 2.4.1-2 ボリューム番号 0 を選択した様子 
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2.4.3. 材料物性データの作成 

メニューで“Tools” > “Set Material Properties”を選択すると図 2.4.1-3 に示すような材料デ

ータ設定ダイアログが表示されます。材料データ設定ダイアログ上でのタブの切り替えは、

メインウィンドウ上でのボリュームのハイライトと連動しているので、どのボリュームに

材料データを設定しているのかということを確認しながら行うことが出来ます。 

 

 
図 2.4.1-3 材料データ設定ダイアログ 

 

各種必要な材料データを入力し終わった後の材料データ設定ダイアログを図 2.4.1-4に示

します。 

 

 
図 2.4.1-4 材料データを入力した後の設定ダイアログ 

 

この状態で“Register”ボタンをクリックすることで材料データを設定することが出来ます。

設定後のダイアログを図 2.4.1-5 に示します。“Material ID”の項目が“ID0”になっていること

がわかります。 
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図 2.4.1-5 材料データを登録した後の設定ダイアログ 

 

続いて別のボリュームに材料データを設定します。先ほど材料データを設定したタブと

は違うタブをクリックすると、別のボリュームに材料データを設定することができます。

タブを切り替えた後の設定ダイアログを図 2.4.1-6 に示します。 

 

 
図 2.4.1-6 タブを切り替えた直後の材料データ設定ダイアログ 

 

“Material ID”が“undefined”となっていることがわかります。新しく材料データを入力し、

“Register”ボタンをクリックすると別の新しい材料データを設定することができます。 
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2.4.4. 登録済みの物性値を別ボリュームに適用する 

すでに登録した物性 ID を別ボリュームに適用することや、その物性 ID の内容を上書き

することも可能です。図 2.4.1-6 において、”Material ID”のプルダウンメニューからボリュ

ーム 0 で設定した”ID0”を選択すると、先ほど設定したのと同じ材料データを設定すること

ができます(図 2.4.1-7)。このとき”Register”ボタンは”Update”ボタンに変わり、”ID0”の物性

値の上書きが可能になります(押さない場合は”ID0”の値がそのままボリューム 1 に適用さ

れます)。ここでポアソン比を”0.4”に書き換え、”Update”ボタンを押すと”ID0”のポアソン

比が更新されます(図 2.4.1-8)。また、すでに”ID0”を適用したボリューム 0 のポアソン比も

更新されていることが確認できます(図 2.4.1-9)。 

 

 
図 2.4.1-7 ボリューム 1 に”ID0”を適用した様子 

 

 
図 2.4.1-8 “ID0”のポアソン比更新 
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図 2.4.1-9 ポアソン比更新後のボリューム 0 

 

2.4.5. 物性値の保存 

すべてのボリュームに材料データを設定し終わったら、設定ダイアログ下部にある

“Refer”ボタンをクリックし材料データを書き出すためのファイル(物性値ファイル)の場所

を選択します。ファイル指定後のダイアログを図 2.4.1-10 に示します。なお、この例では

ボリューム 1 の物性値として”YoungModulus”を”21500”、”PoissonRatio”を”0.2”に設定し

図 2.4.1-5 と同様の方法で”ID1”として登録しています。 

 

 
図 2.4.1-10 保存場所指定後の設定ダイアログ 

 

ファイルを指定した後、“Save”ボタンをクリックして保存を行います。 

作成した物性値ファイルの内容の例をリスト 2.4.1-1 に示します。 
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リスト 2.4.1-1 作成した物性値ファイルの内容の例 

#materialInfo 

materialN   2 

propertyN   2 

YoungModulus   21000 

PoissonRatio   0.3 

YoungModulus   21500 

PoissonRatio   0.2 

#volumeInfo 

volumeN   2 

0 

1 

 

2.5. 一体型解析ファイルの作成 

メッシュに対して境界条件と物性値を貼り付け、ADVENTURE_IO形式の一体型入力フ

ァイルを作成します。 

このステップでの入力ファイル、出力ファイルは以下のとおりです。 

入力ファイル: 

 メッシュデータファイル   (拡張子は msh) 

 メッシュ表面データファイル  (拡張子は fgr) 

 解析条件ファイル   (拡張子は cnd) 

 グローバルインデックスファイル  (拡張子は trn) 

 物性値ファイル    (拡張子は dat) 

出力ファイル: 

 一体型入力ファイル   (拡張子は adv) 

 

このステップでは、makefem3 を使用します。makefem3 はオプション無し(デフォルトモ

ード)ではADVENTURE_Metis Ver.1対応の一体型入力ファイルを出力します。-v2オプショ

ンを付けて実行するとと、ADVENTURE_Metis Ver.2対応の一体型入力ファイルを出力しま

す。 

makefem3 のコマンドライン引数の指定方法は、次のようになります。 

% makefem3 [オプション] mshFile fgrFile cndFile datFile advFile [-t 

trnFile] 

[…] は省略可能な引数です。 

 

 入力ファイル 

 mshFile 

メッシュデータファイル名 

 fgrFile 

メッシュ表面データファイル名 

 cndFile 

境界条件ファイル名 

 datFile 

物性値ファイル名 

 trnFile 

グローバルインデックスファイル名 

 出力ファイル 

 advFile 

一体型入力ファイル名 

 その他のオプション 
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 -solid 

構造解析用の境界条件のみを一体型入力ファイルに出力する。 

 -thermal 

熱解析用の境界条件のみを一体型入力ファイルに出力する。 

 -sflow 

熱流体解析用の境界条件のみを一体型入力ファイルに出力する。 

 -v2 

ADVENTURE_Metis Ver.2 用の一体型入力ファイルを出力する 

 

cnd ファイルに記述されている節点番号が pch 節点番号の場合(BcGUI2 で作成した cnd

はこちらです)は、trnFile を与えてください。pch 節点番号を msh 節点番号に変換して処

理を行います。cndファイルに記述されている節点番号がmsh節点番号以外のとき trnFile

は省略することは出来ません。 

 

2.6. 時刻歴データの追加 

動解析を行う場合に時刻歴データを用いることで、境界条件を時間変化させることが出

来ます。時刻歴データは ADVENTURE_IO 形式で用意する方法と直接ソルバに CSV 形式

のデータを読み込ませる方法の 2種類があります。ADVENTURE_IO形式で用意した場合

でも、時刻歴データのみ記述した単独 adv ファイルとしてソルバに読ませる方法と、一体

型入力ファイルに合体する方法と 2種あります。本マニュアルでは、ADVENTURE_IO形

式で用意して一体型入力ファイルに合体する方法について説明します。時刻歴データを

a2adv 形式のファイルに変換するために csv2adv という perl スクリプトを使います。 

 

csv2adv のコマンドライン引数の指定方法は、次のようになります。 
% csv2adv.pl [option]  <output_file> <input_file> 

[<input_file> ...]  

入力ファイル 

 <input_file>:  CSV 形式の入力ファイル名、複数指定可能 

出力ファイル 

 <output_file>:  出力される a2adv 用テキストファイル 

オプション 

 -version, -v:  バージョン表示を行う 

 -help, -h:   ヘルプを表示を行う 

 

csv2adv で時刻歴入力ファイルを a2adv 形式に変換した後、a2adv の add オプションを

使って既存の Solid 用一体型入力ファイルに追加します。 
% a2adv.pl -add <input_file> [<input_file> …] <output_file> 

入力ファイル 

 <input_file>:  a2adv 用入力ファイル、複数指定可能 

出力ファイル 

 <output_file>:  Solid 用一体型入力ファイル 
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2.7. MPCの設定 

BCtool では、2 種類の MPC 設定方法を提供しています。 

1 つ目は、面と面を完全固着するだけの簡易的な方法です。2 つ目は様々な MPC を手動

で設定する方法です。前者の方法では MasterSlaveTool を、後者の方法では BcGUI2 と

MpcLocal2Global を使用します。 

 

2.7.1. MasterSlaveToolを使う方法 

接触する二つの大きさの異なる立方体のサンプルである 2boxを使用して、コマンドと処

理内容を説明します。 

 

メッシュファイル合成 

MPC_mshmrg を用いて、予め用意されたメッシュファイル leftc.msh, rightc.msh を元

に MPC_merged.msh を合成します。ここでは、 
% MPC_mshmrg.pl leftc.msh rightc.msh 

と入力すると、合成されたメッシュファイル MPC_merged.msh が出力されます。

MPC_merged.msh の形状を図 2.7-1 に 示します。図 2.7-1 の小さい立方体が leftc.msh由来、

大きい立方体が rightc.msh 由来の部分になります。 

 

図 2.7-1 2box の MPC_merged.msh の形状 

 

メッシュの表面の抽出 

msh2pch を用いて、MPC_merged.msh を元にメッシュの表面を抽出及びグループ化し、

GUI の入力フォーマットへ変換します。ここでは、メッシュファイル名を

MPC_merged.msh 、2 面狭角を 60(=180/3)度として、 
% msh2pch MPC_merged.msh 3 

と入力します。以下のファイルが出力されます。 

 MPC_merged_3.fgr：メッシュ表面データファイル 

 MPC_merged_3.pch：表面メッシュ抽出データファイル 

 MPC_merged_3.pcg：表面パッチグループデータファイル 

 MPC_merged_3.trn：グローバルインデックスファイル 
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MPC 作成 

MPC_assem2 を用いて、メッシュファイル、メッシュ表面データファイル及び cmb フ

ァイルを元に節点座標の異なる面を結合するMPC を出力します。このとき、面グループ 5

と 8 の 1 組をペアとして、combi.cmb ファイルを作成しておきます。ここでは、 
% MPC_assem2 MPC_merged.msh MPC_merged_3.fgr combi.cmb > 

MPC_merged_3.mpc 

と入力し、テキストエディタで MPC_merged_3.mpc の行数を調べて先頭に

「LinearConstraint 行数」を書きます。 

 

a2adv による Adv ファイル作成 

a2adv.plを用いて、MPCファイルを元に ADVENTURE_IO 形式の一体型解析モデルフ

ァイルを出力します。ここでは、 
% a2adv.pl MPC_merged_3.mpc LinearConstraint.adv 

と入力します。LinearConstraint.adv が出力されます。 

 

境界条件の設定（荷重、拘束） 

BcGUI 2.0 を用いて、境界条件を設定します。境界条件を設定したい節点または面グル

ープを選択し、メニューから「BC->BC(Solid)->Add SurfaceTraction」(荷重設定)または

「BC->BC(Solid)->Add Displacement」(拘束または強制変位)を選択すると、境界条件設

定ダイアログが表示されます。 

ここでは、図 2.7-2 に示した面グループ 11 を選択し、メニューから「BC->BC(Solid)-

>Add SurfaceTraction」を選択します。そして、ダイアログの"X"の左にあるチェックボ

タンを選択し、その右にあるテキストボックスに"10"と入力して"OK"ボタンをクリックし

ます(面グループ番号 11 に、X 方向に、強さ 10 の荷重を負荷)。 

同様に、図 2.7-3 に示した面グループ 2 を選択し、メニューから「BC->BC(Solid)->Add 

Displacement」を選択して、"X", ”Y”, ”Z”の左にあるチェックボタンを選択し、その右の

テキストボックスには全て"0"を入力します(面グループ番号 2 の変位を全方向拘束)。 
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図 2.7-2 面グループ 11 の選択及び荷重条件の設定 

 

 

 
図 2.7-3 面グループ 2 の選択及び変位拘束条件の設定 
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境界条件を設定し終えたら、メニューで"File" > "Save Condition"を選択して、表示される

ファイル選択ダイアログでファイル名を”MPC_merged_3.cnd”と入力して保存してくださ

い。 

 

物性値設定 

物性値ファイルをテキストエディタで作成します。ここでは、ファイル名を

MPC_merged_3.mat とし、ヤング率 21000.0、ポアソン比 0.3 として、 

YoungModulus 21000.0 

PoissonRatio 0.3 

と入力します。 

 

makefem3 による Adv ファイル作成 

makefem3 を 用 い て、 メ ッ シ ュ に 対 し て境 界 条 件 と 物 性 値 を貼 り 付 け 、

ADVENTURE_IO 形式の一体型解析モデルファイルを作成します。ここでは、 
% makefem3 MPC_merged.msh MPC_merged_3.fgr MPC_merged_3.cnd 

MPC_merged_3.mat MPC_merged_3.adv –t MPC_merged_3.trn 

と入力します。 

 

Adv ファイル合成 

advcat を用いて、a2adv と makefem3 で作成した Adv ファイルを合成します。ここで

は、 
% advcat MPC_merged_3.adv LinearConstraint.adv 2box.adv 

と入力します。MPC条件を含んだ一体型入力ファイル 2box.adv が出力されます。 

 

2.7.2. MpcLocal2Globalを使う方法 

MpcLocal2Global は、表面パッチベースの節点や面グループの MPC 条件データファイ

ルを四面体メッシュベースの MPC 条件データファイルに変換するためのプログラムです。

図 2.1-3 にデータフローを示します。 

 

実行例 

一次節点のみに MPC 条件を付加する場合 

例えば 
% MPCLocal2Global doubleNut.pch doubleNut.trn doubleNut.pcg 

doubleNutMpc.cnd doubleNut.msh 

を実行すると、以下のファイルが cnd ファイルのあるディレクトリに新しく出来ます。 

   ./doubleNutMpc.mpc 
 

二次節点にも MPC 条件を付加する場合 

例えば 
% MPCLocal2Global -s doubleNut.pch doubleNut.trn doubleNut.pcg 

doubleNutMpc.cnd doubleNut.msh doubleNut.fgr 

を実行すると、以下のファイルが cnd ファイルのあるディレクトリに新しく出来ます。 

   ./doubleNutMpc.mpc 

 

これらのコマンドで出力された mpc ファイルは、MasterSlaveTool を使った時と同様の手

順で、a2advと advcat を使って一体型入力ファイルと合成します。 
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3. 熱解析 
3.1. データフロー 

温度及び熱流束等の熱解析用境界条件を有するデータの作成方法では、msh2pch、

BcGUI 及び makefem3(内部で a2adv を呼ぶ)を使用します。図 3.1-1 にこの方法についての

データフローを示します。 

 

図 3.1-1 Thermal 用データ作成時のデータフロー図 

 

熱解析用の境界条件を設定する場合、BcGUI を用いて熱解析用境界条件を、テキストエ

ディタを用いて物性値データを作成します。 

全体のフローは、 

(1) メッシュの表面の抽出 

(2) BcGUI による境界条件の設定 

(3) テキストエディタを用いた材料データの作成 

(4) Thermal 用一体型入力ファイルの作成 

の 4 ステップとなります。 

 

3.2. メッシュの表面の抽出 

メッシュの表面を抽出およびグループ化し、BcGUI の入力フォーマットへ msh2pch を

使って変換します。msh2pch にはコマンドライン引数が２つあります。 
% msh2pch mshFile div_n 

 mshFile :メッシュデータファイル名。シングルボリューム、マルチボリュームい

ずれも利用可能です。 

 div_n :メッシュ表面のグループ化の基準となる 2 面挟角の指定。2 面挟角が指

定した角度以上の面は別のグループになる。90 度の何分の１かで指定する。 
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例-1）メッシュデータファイル名が Model.msh、2 面挟角が 30 度（=90/3) 
 % msh2pch Model.msh 3 

例-2）メッシュデータファイル名が Model.msh、2 面挟角が 45 度（=90/2） 
 % msh2pch Model.msh 2 

2 面挟角を何度に指定するのが適当かはモデルによって異なります。グループ化が粗す

ぎるか、細かすぎるかは BcGUI での表示を見て、ユーザーが判断します。 

メッシュデータファイル名が Model.msh、2 面挟角が 90/N 度の場合、出力ファイル名

は以下のようになります。 

 Model_N.fgr  :メッシュ表面データファイル 

 Model_N.pch  :表面メッシュ抽出データファイル 

 Model_N.pcg :面グループデータファイル 

 Model_N.trn :グローバルインデックスファイル 

 

3.3. BcGUI2による熱解析用境界条件の設定 

境界条件の設定には、GUI ベースのツールである BcGUI2 を使用します。このステップ

での入力ファイル、出力ファイルは以下のとおりです。 

入力ファイル： 

 表面メッシュ抽出データファイル   (拡張子 pch) 

 面グループデータファイル   (拡張子 pcg) 

出力ファイル： 

 解析条件ファイル    (拡張子 cnd) 

 

3.3.1. 起動方法 

BcGUI2 の起動方法は、構造解析の時と同じなので、2.3.1 をご覧ください。 

インストールフォルダの下の samples フォルダにある requestModel_3.pch と

requestModel_3.pcg を読み込んだ後の画面を図 3.3-1 に示します。 

 

 

図 3.3-1 case5-quadratic_4 を表示した様子 
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3.3.2. マウスによる視線移動方法 

構造解析での説明(2.3.2)を参照してください。 

 

3.3.3. 表面一次節点、面グループの選択方法 

構造解析での説明(2.3.3)を参照してください。 

 

3.3.4. 境界条件の設定方法(面グループに対する熱解析用境界条件) 

図 3.3-2 に示すように、熱解析用境界条件を設定したい面グループを選択します。その

状態でメニューから"BC" > ”BC(Thermal)” > "Add Temperature"を選択すると図 3.3-3 に

示すようなダイアログが表示されます。このダイアログの場合は、面グループに温度規定

境界条件を設定することができます。また熱解析において時刻歴データは無視されますの

で、”Transient Table ID”に値を設定しても実際に解析時に用いられることはありません。 

温度条件を入力したら”OK”ボタン を選択し、実際に条件を面グループに付加します。 

 

 
図 3.3-2 面グループ選択 

 

 
図 3.3-3 熱解析用境界条件設定ダイアログ 
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3.3.5. 境界条件の確認方法(熱解析用境界条件を付与した面グループの確認) 

面グループの選択を解除してから、メニューで"View" > "Boundary Condition" > "View 

Temperature"を選択します。図 3.3-4 のように赤色で温度規定境界条件を付加した面グル

ープがハイライトされます。  

温度規定境界条件の表示を解除するには、メニューで"View" > "Boundary Condition" > 

"None"を選択して下さい。 

 

 
図 3.3-4 温度規定境界条件を付加した面グループをハイライトした画面 

 

3.3.6. 境界条件の設定方法(節点に対する熱解析用境界条件) 

図 3.3-5 に示すように、熱解析用境界条件を設定したい節点を選択します。その状態で

メニューから"BC" > ”BC(Thermal)” > "Add Temperature"を選択すると図 3.3-6 に示すよ

うなダイアログが表示されます。このダイアログ上で節点に温度規定境界条件を設定する

ことができます。また熱解析において時刻歴データは無視されますので、 ”Transient 

Table ID”に値を設定しても実際に解析時に用いられることはありません。 

温度条件を入力したら”OK”ボタン を選択し、実際に条件を節点に付加します。 

 
図 3.3-5 節点選択 
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図 3.3-6 熱解析用境界条件設定ダイアログ 

 

3.3.7. 境界条件の確認方法(熱解析用境界上件を付与した節点の確認) 

節点の選択を解除してから、メニューで "View" > "Boundary Condition" > "View 

Temperature"を選択します。図 3.3-7 のように赤色で温度規定境界条件を付加した節点が

ハイライトされます。  

温度規定境界条件の表示を解除するには、メニューで"View" > "Boundary Condition" > 

"None"を選択して下さい。 

 
図 3.3-7 温度規定境界条件を付加した節点をハイライトした画面 

 

3.3.8. その他の熱解析用境界条件 

面グループに対し"BC" > “BC(Thermal)” > “Add HeatFlux”より熱流束規定境界条件を付

加することができます。 

面グループに対し"BC" > “BC(Thermal)” > “Add HeatTransfer”より熱伝達規定境界条件

を付加することができます。 

面グループに対し"BC" > “BC(Thermal)” > “Add HeatRadiation”より熱ふく射規定境界

条件を付加することができます。 

設定方法は今までのものと同様です。 

 

 

 

 



42 

 

3.3.9. 境界条件のクリア 

先ず図 3.3-8 のステータスバーに示すように、面グループ番号 5 に温度規定境界条件を

設定した後、 

“BC” > "BC(Thermal)" > "Clear Temperature"  

を選択します。 

 
図 3.3-8 面グループ 5 の温度規定境界条件をステータスバーに表示 

 

すると図 3.3-9 のダイアログで、念を押してきますので、良ければ"了解"をクリックして

下さい。 

 
図 3.3-9 温度規定境界条件消去の確認ダイアログ 

 

再度面グループ 5 を選択すると、図 3.3-10 のように、ステータスバーからは、温度規定

境界条件の表示が消えております。もし同じ種類の条件を複数設定していれば、それら全

てが削除されます。 

 
図 3.3-10 面グループ 5 に関する温度規定境界条件が消去された様子 
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"BC” > “BC(Thermal)" > "Clear HeatFlux"  

温度規定境界条件のときと同様です。 

 

"BC” > “BC(Thermal)" > "Clear HeatTransfer"  

温度規定境界条件のときと同様です。 

 

"BC” > “BC(Thermal)" > "Clear HeatRadiation"  

温度規定境界条件のときと同様です。 

 

3.3.10. 既に設定した拘束や荷重の内容確認や修正 

既に条件を設定した面グループや節点を選択してから、メニューで"BC" > “BC(Solid)” > 

"Add Displacement"や"BC" > “BC(Thermal)” > "Add SurfaceTraction"を選択すると、表

示されるダイアログに既に設定した条件の内容が表示されます。そのダイアログで設定を

変更して、"OK"ボタンをクリックすると、設定が上書き修正されます。 

また”View” > “Boundary Condition” > “Cnd format”から、現在設定されている境界条件

のリストを見ることができます。 

 

3.3.11. 境界条件の保存 

起動時に-ocnd オプションを指定したときは、この操作は不要です。 

メニューで"File" > "Save Condition"を選択して、表示されるファイル選択ダイアログで

保存するファイル名を入力して保存してください。拡張子の cnd は抜けていれば自動的に

補われます。既存のファイルを指定すると警告が表示されます。 

保存したファイルの内容をリスト 3.3-1 保存した境界条件 設定ファイル(*.cnd)に示しま

す。尚、この操作により、本プログラム起動以後に設定した全ての通常境界条件が保存さ

れます。 

 

リスト 3.3-1 保存した境界条件 設定ファイル(*.cnd)の内容 

gravity 0.0 0.0 0.0 

boundary 4 

tracOnFaceGroup 11 0 2 -1.0 

Transient 1 dispOnFaceGroup 0 0 0 0.0 

Transient 1 dispOnFaceGroup 0 0 1 0.0 

Transient 1 dispOnFaceGroup 0 0 2 0.0 

cnd ファイルのフォーマットについては 9.10 を参照して下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

3.4. テキストエディタによる材料データの作成 

熱解析用の材料データはテキストエディタを用いて作成します。指定できる物性値は表 

3.4-1 に示す 4 種類です。  
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表 3.4-1 指定できる物性値一覧 

物性値の名称 物性を示すラベル 備考 

熱伝導率 HeatConductivity 熱解析時に使用 

比熱 SpecificHeat  熱解析時(非定常解析)に使用 

ステファンボルツマン係数 StefanBoltzmanConstant  熱解析時(熱ふく射解析時)に使用 

内部発熱 InternalHeatGeneration  熱解析時に使用 

 

3.5. 一体型解析ファイルの作成 

メッシュに対して境界条件と物性値を貼り付け、ADVENTURE_IO形式の一体型入力フ

ァイルを作成します。 

このステップでの入力ファイル、出力ファイルは以下のとおりです。 

入力ファイル: 

 メッシュデータファイル   (拡張子は msh) 

 メッシュ表面データファイル  (拡張子は fgr) 

 解析条件ファイル   (拡張子は cnd) 

 グローバルインデックスファイル  (拡張子は trn) 

 物性値ファイル    (拡張子は dat) 

出力ファイル: 

 一体型入力ファイル   (拡張子は adv) 

 

このステップでは、makefem3 を使用します。makefem3 はオプション無し(デフォルトモ

ード)ではADVENTURE_Metis Ver.1対応の一体型入力ファイルを出力します。-v2オプショ

ンを付けて実行するとと、ADVENTURE_Metis Ver.2対応の一体型入力ファイルを出力しま

す。 

makefem3 のコマンドライン引数の指定方法は、次のようになります。 

% makefem3 [オプション] mshFile fgrFile cndFile datFile advFile [-t 

trnFile] 

[…] は省略可能な引数です。 

 

 入力ファイル 

 mshFile 

メッシュデータファイル名 

 fgrFile 

メッシュ表面データファイル名 

 cndFile 

境界条件ファイル名 

 datFile 

物性値ファイル名 

 trnFile 

グローバルインデックスファイル名 

 出力ファイル 

 advFile 

一体型入力ファイル名 

 その他のオプション 

 -solid 

構造解析用の境界条件のみを一体型入力ファイルに出力する。 

 -thermal 

熱解析用の境界条件のみを一体型入力ファイルに出力する。 

 -sflow 
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熱流体解析用の境界条件のみを一体型入力ファイルに出力する。 

 -v2 

ADVENTURE_Metis Ver.2 用の一体型入力ファイルを出力する 

 

cnd ファイルに記述されている節点番号が pch 節点番号の場合(BcGUI2 で作成した cnd

はこちらです)は、trnFile を与えてください。pch 節点番号を msh 節点番号に変換して処

理を行います。cndファイルに記述されている節点番号がmsh節点番号以外のとき trnFile

は省略することは出来ません。 
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4. 熱流体解析 
ここでは BcGUI を利用して熱流体解析に関する境界条件設定を行います。 

4.1. メッシュ表面の抽出 

熱解析のとき同様、 
% msh2pch mshFile div_n 

でメッシュ表面の抽出を行い、生成された pch ファイルと pcg ファイルを BcGUI で読

み込みます。 

 

4.2. BcGUIによる熱流体解析用境界条件の設定 

4.2.1. 起動方法 

BcGUI2 の起動方法は、構造解析の時と同じなので、2.3.1 をご覧ください。 

samples フォルダにある Solid_3.pch と Solid_3.pcg を選択して起動した場合の画面を図 

4.2-1 に示します。 

 

 

図 4.2-1 Solid_3 を表示した様子 

 

 

4.2.2. マウスによる視線移動方法 

構造解析での説明(2.3.2)を参照してください。 

 

4.2.3. 表面一次節点、面グループの選択方法 

構造解析での説明(2.3.3)を参照してください。 
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4.2.4. 境界条件の設定方法(流速) 

“BC” > “BC(Solid)” > “Add Velocity”で流速の境界条件を追加します(図 4.2-2)。 

 

 
図 4.2-2 流速境界条件の設定 

 

4.2.5. 境界条件の設定方法(圧力) 

“BC” > “BC(Solid)” > “Add Pressure”で圧力の境界条件を追加します(図 4.2-3)。 

 

 
図 4.2-3 圧力境界条件の設定 

 

4.2.6. 境界条件の設定方法(温度) 

“BC” > “BC(Thermal)” > “Add Temprature” で温度の境界条件を追加します(図 4.2-4)。 

 

 
図 4.2-4 温度境界条件の設定 
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4.2.7. 境界条件の保存 

”File” > “Save Condition”で cnd ファイルを保存します。 

 

4.3. 一体型解析ファイルの作成 

構造解析同様、 

% makefem3 [オプション] mshFile fgrFile cndFile datFile advFile [-t 

trnFile] 

で一体型解析ファイル(拡張子 adv)を作成します。 

詳しくは 2.5 をご覧ください。 
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5. 電磁界解析 
5.1. メッシュ表面の抽出 

ここでは BcGUI を利用して電磁界解析に関する境界条件設定を行います。 

熱解析のとき同様、 
% msh2pch mshFile div_n 

でメッシュ表面の抽出を行い、生成された pch ファイルと pcg ファイルを BcGUI で読み

込みます。 

 

5.2. BcGUIによる電磁界解析用境界条件の設定 

5.2.1. 起動方法 

6. BcGUI2 の起動方法は、構造解析の時と同じなので、2.3.1 をご覧ください。 

samples フォルダにある Magnetic_3.pch と Magnetic_3.pcg を選択して起動した場合の

画面を図 5.2-1 に示します。 

 

 

図 5.2-1 Magnetic_3 を表示した様子 

 

 

6.1.1. マウスによる視線移動方法 

構造解析での説明(2.3.2)を参照してください。 

 

6.1.2. 表面一次節点、面グループの選択方法 

構造解析での説明(2.3.3)を参照してください。 
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6.1.3. 境界条件の設定方法(磁気ベクトルポテンシャル) 

境界条件を設定したい面を選択します。境界条件設定ウィンドウの”BC”  > ”

BC(Magnetic)” > ”Add Magnetic Vector Potential”を選んでください。磁気ベクトル

ポテンシャル境界条件設定ダイアログが出てきます(図 5.2-2)。 

 

 
図 5.2-2 磁気ベクトルポテンシャル境界条件の設定 

 

“Normal”にチェックを入れ、「OK」をクリックしてください。なお、磁気ベクトルポ

テンシャルの法線方向成分は 0 に設定します。 

 

6.1.4. 境界条件の保存 

”File” > “Save Condition”で cnd ファイルを保存します。 

 

6.2. 一体型解析ファイルの作成 

makefem3 は 電 磁 界 解 析 に は 未 対 応 の た め 、 ADVENTURE_MAgnetic の

advmag_makefem で一体型解析ファイルを作成します。 
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7. Appendix A コマンドリファレンス 
7.1. Msh2pch 

メッシュの表面を抽出およびグループ化し、BcGUI の入力フォーマットへ変換します。 

 

7.1.1. 書式 
% msh2pch mshFile div_n 

 

7.1.2. 説明 

このステップでの入力ファイル、出力ファイルは以下のとおりです。 

入力ファイル： 

 メッシュデータファイル    （拡張子はmsh） 

出力ファイル： 

 メッシュ表面データファイル   （拡張子はfgr） 

 表面メッシュ抽出データファイル   （拡張子はpch） 

 表面パッチグループ(以下面グループ)データファイル （拡張子はpcg） 

 グローバルインデックスファイル   （拡張子はtrn） 

 

このステップでは、Shellスクリプト msh2pch を使用します。msh2pch にはコマンドラ

イン引数が２つあります。 

 mshFile:メッシュデータファイル名。シングルボリューム、マルチボリュームい

ずれも利用可能です。 

 div_n :メッシュ表面のグループ化の基準となる 2 面挟角の指定。2 面挟角が指

定した角度以上の面は別のグループになる。90 度の何分の１かで指定する。 

 

7.1.3. 実行例 

例-1）メッシュデータファイル名が Model.msh、2 面挟角が 30 度（=90/3) 
 % msh2pch Model.msh 3 

 

例-2）メッシュデータファイル名が Model.msh、2 面挟角が 45 度（=90/2） 
 % msh2pch Model.msh 2 

 

2 面挟角を何度に指定するのが適当かはモデルによって異なります。グループ化が粗す

ぎるか、細かすぎるかは BcGUI での表示を見て、ユーザーが判断します。 

メッシュデータファイル名が Model.msh、2 面挟角が 90/N 度の場合、 

出力ファイル名は以下のようになります。 

 Model_N.fgr  :メッシュ表面データファイル 

 Model_N.pch  :表面メッシュ抽出データファイル 

 Model_N.pcg :面グループデータファイル 

 Model_N.trn :グローバルインデックスファイル 

 
7.2. BcGUI2 

対話式境界条件/MPC 条件/物性設定ツール BcGUI2 を起動します。 

 

7.2.1. 書式 
% BcGUI2 pcxFile pcgFile [-icnd cndFile] [-ocnd outFile] 

 

7.2.2. 説明 

 pcxFile :表面メッシュ抽出データファイル名。pch もしくは pcm ファイル。 

 pcgFile :面グループデータファイル名 
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 cndFile :起動時に自動的に読み込む解析条件ファイル名 

 outFile :終了時に自動的に書き込む解析条件ファイル名 

[…]は省略可能です。 

-icnd オプションを指定すると、あらかじめ作成しておいた解析条件ファイルを起動 

時に自動的に読み込むことができます。 

-ocnd オプションを指定することにより、BcGUI の終了時に自動的に解析条件ファ 

イルを出力させることができます。 

 

7.3. Makefem3 

メッシュに対して境界条件と物性値を貼り付け、ADVENTURE_IO形式の一体型入力フ

ァイルを作成します。 

 

7.3.1. 書式 

% makefem3 [オプション] mshFile fgrFile cndFile datFile advFile [-t 

trnFile] 

 

7.3.2. 説明 

入力ファイル 

 mshFile  :メッシュデータファイル名 

 fgrFile  :メッシュ表面データファイル名 

 cndFile  :解析条件ファイル名 

 datFile  :物性値ファイル名 

 trnFile  :グローバルインデックスファイル名 

出力ファイル 

 advFile  :一体型入力ファイル名 

オプション 

 -v2  :ADVENTURE_Metis Ver.2 用の一体型入力ファイルを出力す

る 

 -solid  :応力解析以外の境界条件を出力しない 

 -thermal  :熱解析以外の境界条件を出力しない 

 -sflow  :熱流体解析以外の境界条件を出力しない 

 

[…] は省略可能な引数です。 

このステップでは、makefem3 を使用します。makefem3 はオプション無し(デフォルト

モード)では ADVENTURE_Metis Ver.1 対応の一体型入力ファイルを出力します。-v2 オ

プションを付けて実行するとと、ADVENTURE_Metis Ver.2 対応の一体型入力ファイル

を出力します。 

cnd ファイルに記述されている節点番号が pch 節点番号の場合は、trnFile を与えてくださ

い。pch 節点番号を msh 節点番号に変換して処理を行います。cnd ファイルに記述されてい

る節点番号が msh 節点番号以外のとき trnFile は省略することは出来ません。 

 
7.4. csv2adv 

時刻歴データを a2adv形式のファイルに変換するために csv2advという perlスクリプト

を使います。 

 

7.4.1. 書式 
% csv2adv.pl [option]  <output_file> <input_file> 

[<input_file> ...]  
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7.4.2. 説明 

入力ファイル 

 <input_file>:  CSV 形式の入力ファイル名、複数指定可能 

出力ファイル 

 <output_file>:  出力される a2adv 用テキストファイル 

オプション 

 -version, -v:  バージョン表示を行う 

 -help, -h:   ヘルプを表示を行う 

 

入力ファイルは、CSV 形式(Comma Separated Value)のファイルです。 

動解析を行う場合に時刻歴データを用いることで、境界条件を時間変化させることが出

来ます。時刻歴データは ADVENTURE_IO 形式で用意する方法と直接ソルバに CSV 形式

のデータを読み込ませる方法と 2 種あります。ADVENTURE_IO 形式で用意した場合で

も、時刻歴データのみ記述した単独 adv ファイルとしてソルバに読ませる方法と、一体型

入力ファイルに合体する方法と 2種あります。本コマンドでは、ADVENTURE_IO形式で

用意して一体型入力ファイルに合体します。 

 

7.4.3. 実行例 

・入力ファイルが 1 つの場合  
% csv2adv.pl result.a bc_timehistory.csv  

 

・入力ファイルが 3 つの場合  
% csv2adv.pl result.a 1-1.csv 1-2.csv 1-3.csv 

 
7.5. a2adv 

csv2adv で時刻歴入力ファイルを a2adv 形式に変換した後、a2adv の add オプションを

使って既存の Solid 用一体型入力ファイルに追加します。 

 

7.5.1. 書式 
% a2adv.pl -add <input_file> [<input_file> …] <output_file> 

 

7.5.2. 説明 

入力ファイル 

 <input_file>:  a2adv 用入力ファイル、複数指定可能 

出力ファイル 

 <output_file>:  Solid 用一体型入力ファイル 

 

7.5.3. 新しい要素タイプ，FEGA の登録 

要素タイプの追加の場合は、a2adv.pl.in 中の%element_format の定義箇所で、その

format を追加します。 

ex. 
%element_format = ( 

. 

'NewElementType' => i4i4i4i4, #4 

. 
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FEGA の場合は、a2adv.pl.in の%fega_type の定義中にその fega_type を、さら

に%fega_format の定義中にその format を追加します。 

ex. 
%fega_types = (  

. 

'NewFEGALabel' => AllNodeVariable, 

.  

%fega_format = (  

. 

'NewFEGALabel' => i4f8, 

. 

 

なお，FEGA については未登録でも、入力テキストファイルのほうで fega_type と

format のプロパティを記述することで、ADV 形式に変換可能です。サンプルファイル

samples/unknownlabel.dat を参照してください。 

 
7.6. PcmMerge 

スクリプトにより、Java で書かれたプログラムと ADVENTURE_TriPatch の 1 ツール

mrpach が実行されます。 

 

7.6.1. 書式 

スクリプトファイルの置き場と mrpach に PATH が通っているという前提で 

% PcmMerge [オプション] pcmFileA pcmFileB [-o outPcmFile] [-g 

outPcgFile] [-m moveInfoFile] 

 

7.6.2. 説明 

 pcmFileA(入力) 

 表面パッチデータファイルの一方です。こちらはこのスクリプトの処理によって移

動されない方です。pcm 又は pch フォーマットのいずれも利用可能です。 

 pcmFileB(入力) 

表面パッチデータファイルの他方です。こちらは二つの表面パッチが離れていると

きまたは干渉があるときに、ちょうど接触する位置まで移動される方です。pcm 又

は pch フォーマットのいずれも利用可能です。 

 

表面パッチデータファイルの pcm フォーマットについては、ADVENTURE_TriPatch

マニュアルの、「6.2 表面パッチデータファイル」の項をご覧下さい。pch フォーマット

については、本マニュアルの「9. Appendix C 」の「9.5. 表面メッシュ抽出データファイ

ル(拡張子 pch)」の項をご覧下さい。 

 

7.6.3. オプション 

 -t または--tolerance(入力) 

表面パッチの対応する 2 つの面に隙間があるとき、tolerance で指定した距離以下

ならば、接触しているものとみなし、表面パッチの移動は行いません。デフォール

トは 1.e-5 です。 

 -a または--angle(入力) 

2 面挟角がユーザーが指定した角度以上の二つの要素面は別のグループになりま

す。デフォールトは 45 度です。 

 -o outPcmFile 

pcmFileA と pcmFileB をマージした表面パッチファイルです。ボリューム間境界

上の節点は二重に存在します。省略時のファイル名は out.pcm 
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 -g outPcgFile 

pcmFileA と pcmFileB をマージした表面パッチの表面パッチグループデータファ

イルです。省略時のファイル名は out.pcg 

 -m moveInfoFile 

moveInfo.dat には 2 つのボリューム間の位置関係のタイプ(接触、分離、陥入)、移

動する方の表面パッチのボリューム ID と移動量ベクトルが記述されます。省略時

のファイル名は moveInfo.dat。 

他にも modelA.pcg、modelA.pcm、modelB.pcg、及び modelB.pcm が出力されま

すが、これらは後の処理では不要です。 

 -h 又は—help 

本プログラムの使用方法を表示するオプションです。 

 -version 

本プログラムのバージョンを表示するオプションです。 

 
7.7. MergeCheck 

スクリプトにより、Java で書かれたプログラムが実行されます。 

 

7.7.1. 書式 

% MergeCheck [オプション] mshFile moveInfoFile outputFile 

 

7.7.2. 説明 

 mshFile(入力) 

四面体メッシュファイルです。一次要素、二次要素のいずれでも利用可能です。 

 moveInfoFile(入力) 

PcmMerge.sh の実行により生成されたファイルを使用します。ボリューム間の位

置関係のタイプ(接触、分離、陥入)、移動する方の表面パッチのボリューム ID と移

動量ベクトルが記述されます。 

 outputFile(出力) 

本プログラムにより生成される 3 つのファイルです。ouputFile.msh、

outputFile.np 及び outputFile.nv が出力されます。 

➢ outputFile.msh 

ボリューム間境界節点が分離された 2 ボリューム四面体メッシュファイルで

す。 

➢ outputFile.np 

各ボリューム表面の対応する 2 つの面グループ上の節点ペアの番号を記述した

ファイルです。このファイルのフォーマットを 9.15.1.節に示します。 

➢ outputFile.nv 

各ボリューム表面の対応する 2 つの面グループ上の各節点における法線ベクト

ルを記述したファイルです。 

 

7.7.3. オプション 

 -h 又は—help 

本プログラムの使用方法を表示するオプションです。 

 -v 又は—version 

本プログラムのバージョンを表示するオプションです。 
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7.8. MPC_mshmrg 

メッシュデータファイルを合成します。 

 

7.8.1. 書式 
% MPC_mshmrg.pl xxx.msh yyy.msh zzz.msh 

 

7.8.2. 説明 

xxx.msh : 入力メッシュファイル 1 

yyy.msh : 入力メッシュファイル 2 

zzz.msh : 出力メッシュファイル 

 
7.9. MPC_assem2 

面同士の完全固着のみの MPC を作成します。 

 

7.9.1. 書式 
% MPC_assem2 aaa.msh bbb.fgr ccc.cmb > ddd.mpc 

 

7.9.2. 説明 

 aaa.msh (入力) 

メッシュファイル 

 bbb.fgr (入力) 

aaa.msh の表面グループファイル。 

 ccc.cmb (入力) 

9.14 節で定義する面グループペア設定ファイル。 

 ddd.mpc (出力) 

MPC 記述ファイル。 

 

MPC_assem2 が出力する mpc ファイルは、先頭の条件数定義の行が存在しません。

MPC_assem2 を実行後、テキストエディタで ddd.mpc の行数を調べて先頭

に”LinearConstraint 行数”を書いてください。 

 

7.10. a2adv 

ADV ドキュメントのテキスト表現ファイル(atx ファイル)から ADV ファイルへのコンバ

ータです。 

 

7.10.1. 書式 
% a2adv.pl [option]  <input_file> [ <input_file> ... ] 

<output_file> 

 

7.10.2. 説明 

 <input_file> 

ASCII 形式の入力ファイル名。複数指定可能です。  

"-" の場合、標準入力から読み込みます。ただし、fem ファイル、msh ファイルの

標準入力からの読み込みは不可で、atx形式(a2adv 形式)のみに対応しています。 

 <output_file> 

出力される ADVENTURE IO Format ファイル名。 

 

7.10.3. オプション 

-add:  出力ファイルを新規に作成せず、既存のファイルがあれば追加を行います。 
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7.11. MpcLocal2Global 

表面パッチベースの節点や面グループの MPC 条件データファイルを四面体メッシュベ

ースの MPC 条件データファイルに変換するためのプログラムです。 

 

7.11.1. 書式 

一次節点のみの処理の場合 
% MPCLocal2Global pchFile trnFile pcgFile cndFile 

 

二次節点迄処理する場合 
% MPCLocal2Global -s pchFile trnFile pcgFile cndFile mshFile 

fgrFile 

 

7.11.2. 説明 

 cndFile(入力) 

解析条件を記述するフォーマットを MPC 条件用に拡張したフォーマットを持ちま

す。7 種類の MPC 条件を記述することが出来ます。勿論混在も可です。詳細につ

いては、9.12 節を参照してください。 

 pchFile(入力) 

表面メッシュ抽出データファイルです。本プログラムでは四面体メッシュの表面の

みを取り扱い対象とします。詳細については、9.5 節を参照してください。 

 trnFile(入力) 

pchFile の節点番号からメッシュファイル(拡張子 msh)の節点番号への対応を示す

データファイルです。メッシュファイルは本プログラムでは使用しませんが、メッ

シュファイルが存在することが前提です。詳細については、9.8 を参照してくださ

い。 

 pcgFile(入力) 

表面パッチグループデータファイルです。詳細については、9.7 を参照してくださ

い。 

 fgrFile(入力) 

メッシュ表面データファイルです。詳細については、9.4 を参照してください。 

 mshFile(入力) 

メッシュデータファイルです。詳細については、9.3 を参照してください。 

 mpcFile(出力) 

MPC 条件をメッシュファイルの節点番号で記述したデータファイルです。パラメ

ータで指定する必要はありません。a2adv コマンドの入力データファイルとして使

用することにより、ADVENTURE_IO フォーマットのデータファイルに変換する

ことが出来ます。詳細については、9.13 を参照してください。 

 

7.11.3. オプション 

 -s 

二次節点を処理するときのオプションです。 

 -h 

本プログラムの使用方法を表示するオプションです。 

 --version 

本プログラムのバージョンを表示するオプションです。 
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7.11.4. 実行例 

・一次節点のみに MPC 条件を付加する場合 

例えば 
% MPCLocal2Global doubleNut.pch doubleNut.trn doubleNut.pcg 

doubleNutMpc.cnd doubleNut.msh 

を実行すると、以下のファイルが新しく出来ます。 

   ./doubleNutMpc.mpc 

 

・二次節点にも MPC 条件を付加する場合 

例えば 
% MPCLocal2Global -s doubleNut.pch doubleNut.trn doubleNut.pcg 

doubleNutMpc.cnd doubleNut.msh doubleNut.fgr 

を実行すると、以下のファイルが新しく出来ます。 

   ./doubleNutMpc.mpc 
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8. Appendix B サンプルデータ 
8.1. BcGUI 

8.1.1. 二つのナット(samples/BcGUI/doubleNut.files/) 

形状図を図 8.1-1 に示します。 

 

 
図 8.1-1 Double Nut の形状図 

 

入力ファイル 

 Solid_4.0.pch 

 Solid_4.0.pcg 

出力ファイル 

 MpcI_N.cnd 剛体はり I 節点同士出力例 

 MpcI_SG.cnd 剛体はり I 面グループ同士出力例 

 MpcII_N.cnd  剛体はり II 節点同士出力例 

 MpcII_SG.cnd 剛体はり II 面グループ同士出力例 

 MpcIII_N.cnd  剛体はり III 節点同士出力例 

 MpcIII_SG.cnd 剛体はり III 面グループ同士出力例 

 MpcIV_N.cnd  剛体はり IV 節点同士出力例 

 MpcIV_SG.cnd 剛体はり IV 面グループ同士出力例 

 MpcV_N.cnd 剛体はり V 節点同士出力例 

 MpcLM_N.cnd   任意の MPC 出力例 

解析実行のため、他の工程で使用する参考ファイル 

 Solid_4.0.trn MpcLocal2Global や makefem3 で使用 

 Solid.msh makefem3 で使用 

 Solid_4.0.fgr makefem3 で使用 

 Solid_4.0.cnd makefem3 で使用(通常の境界条件) 

 Solid_mp.dat makefem3 で使用(2 個のボリュームに 2 種の材料を割当てた例) 

 Solid_4.0.adv: makefem3 の結果 
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8.1.2. 重ねた二つのはり(samples/BcGUI/doubleBeam.files/) 

形状図を図 8.1-2 に示します。 

 

 
図 8.1-2 Double Beam の形状図 

 

入力ファイル 

 Solid_2.0.pch 

 Solid_2.0.pcg 

出力ファイル 

 MpcI_N.cnd 剛体はり I 節点同士出力例 

解析実行のため、他の工程で使用する参考ファイル 

 Solid_2.0.trn MpcLocal2Global や makefem3 で使用 

 Solid.msh makefem3 で使用 

 Solid_2.0.fgr makefem3 で使用 

 Solid_2.0.cnd makefem3 で使用(通常の境界条件) 

 Solid_mp.dat makefem3 で使用(2 個のボリュームに 2 種の材料を割当てた例) 

 Solid_2.0.adv makefem3 の結果 

 

8.1.3. はり(samples/BcGUI/beam.files/) 

形状図を図 8.1-3 に示します。 
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図 8.1-3 Beamの形状図 

 

入力ファイル 

 Solid_2.0.pch 

 Solid_2.0.pcg 

出力ファイル 

 So_loadV.cnd 節点集中荷条件のサンプル 

 So_dispV.cnd 節点強制変位条件のサンプル 

 So_dispF.cnd 面グループ強制変位条件のサンプル 

 So_velocV.cnd 節点強制速度条件のサンプル 

 So_velocF.cnd 面グループ強制変位条件のサンプル 

 So_accelV.cnd 節点強制加速度条件のサンプル 

 So_accelF.cnd 面グループ強制加速度条件のサンプル 

 So_presF.cnd 面グループ圧力条件のサンプル 

 So_tracF.cnd 面グループ表面力条件のサンプル 

 Th_tempV.cnd 節点温度条件のサンプル 

 Th_tempF.cnd 面グループ温度条件のサンプル 

 Th_fluxF.cnd 面グループ熱流束条件のサンプル 

 Th_transF.cnd 面グループ熱伝達条件のサンプル 

 Th_radiF.cnd 面グループ熱ふく射条件のサンプル 

解析実行のため、他の工程で使用する参考ファイル 

 Solid_2.0.trn MpcLocal2Global や makefem3 で使用 

 Solid.msh makefem3 で使用 

 Solid_2.0.fgr makefem3 で使用 

 Solid_2.0.cnd makefem3 で使用(通常の境界条件) 

 Solid_mp.dat makefem3 で使用 

 Solid_2.0.adv makefem3 の結果 

 

8.1.4. 六面体(samples/BcGUI/doubleHex/) 

形状図を図 8.1-4 に示します。 
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図 8.1-4 doubleHex の形状図 

 

入力ファイル 

 doubleHex_2.pch 

 doubleHex_2.pcg 

出力ファイル 

 Rigid_Beam_I.cnd  剛体はり I の MPC 条件のサンプル 

 Rigid_Beam_II.cnd  剛体はり II の MPC 条件のサンプル 

 Rigid_Beam_III.cnd 剛体はり III の MPC 条件のサンプル 

 Rigid_Beam_IV.cnd 剛体はり IV の MPC 条件のサンプル 

 

8.1.5. マルチブリック(samples/BcGUI/multiVolume/) 

形状図を図 8.1-5 に示す。 

 

 
図 8.1-5 multiBrick の形状図 
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入力ファイル 

 multiBrick_10.pch 

 multiBrick_10.pcg 

 multiBrick_V.pcm 

 multiBrick_V.pcg 

解析実行のため、他の工程で使用する参考ファイル 

 multiBrick.msh  makefem3 で使用 

 multiBrick_10.fgr  makefem3 で使用 

 multiBrick_10.trn  MpcLocal2Global や makefem3 で使用 

 

8.1.6. 立方体 – 27個(samples/BcGUI/multiVolume/three^3Box/) 

形状図を図 8.1-6 に示す。 

 

 
図 8.1-6 three^3Box の形状図 

 

入力ファイル 

 Solid26mc_V.pcm 

 Solid26mc_V.pcg 

解析実行のため、他の工程で使用する参考ファイル 

 Solid26mc.msh makefem3 で使用 

 

8.1.7. 立方体 – 3個(samples/BcGUI/multiVolume/threeBox/) 

形状図を図 8.1-7 に示す。 
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図 8.1-7 threeBox の形状図 

 

入力ファイル 

 Solid2mc_V.pcm 

 Solid2mc_V.pcg 

解析実行のため、他の工程で使用する参考ファイル 

 Solid2mc.msh makefem3 で使用 

8.2. makefem3 

8.2.1. シングルボリューム四面体 1次要素(samples/makefem3/1ji_single_tetra/) 

サンプルを BcGUI で表示した画面を図 8.2-1 に示します。 

 

 
図 8.2-1 シングルボリューム四面体 1 次要素のサンプルの形状 

 

入力ファイル 
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model/Solid.msh シングルボリューム四面体 1 次要素のメッシュデータファイル 

model/Solid_2.0.fgr メッシュ表面データファイル 

model/Solid_2.0.pcg 表面パッチグループデータファイル 

   (makefem3 では使用しません) 

model/Solid_2.0.pch 表面メッシュグループ抽出データファイル 

   (makefem3 では使用しません) 

model/Solid_2.0.trn グローバルインデックスファイル 

model/Solid_mp.dat 物性値ファイル  (1)(1~2 のうちどれか一つ) 

model/test_mp.dat 物性値ファイル    (2) 

cnd/mix.cnd 解析条件ファイル  (a)(a~i のうちどれか一つ) 

cnd/mix2.cnd 解析条件ファイル    (b) 

cnd/initveloc/initveloc_v.cnd 解析条件ファイル  (c) 

cnd/initveloc/initveloc_fg.cnd 解析条件ファイル  (d) 

cnd/mesh/mesh.cnd 解析条件ファイル   (e) 

cnd/nl_history_id/dispOnVertex.cnd 解析条件ファイル  (f) 

cnd/nl_history_id/dispOnFaceGroup.cnd 解析条件ファイル (g) 

cnd/nl_history_id/loadOnVertex.cnd 解析条件ファイル  (h) 

cnd/nl_history_id/tracOnFaceGroup.cnd 解析条件ファイル (i) 

出力ファイル 

* 括弧内は物性値ファイルと解析条件ファイルの組み合わせ。 

makebc_result/makebc.adv    (1, a) 

makefem3_result/cond.adv    (1, b) 

makefem3_result/initvelocOnVertex.adv  (1, c) 

makefem3_result/initvelocOnFaceGroup.adv  (1, d) 

makefem3_result/material.adv   (2, e) 

makefem3_result/mesh.adv    (1, e) 

makefem3_result/nl_dispOnVertex.adv  (1, f) 

makefem3_result/nl_dispOnFaceGroup.adv  (1, g) 

makefem3_result/nl_loadOnVertex.adv  (1, h) 

makefem3_result/nl_tracOnFaceGroup.adv  (1, I) 

 

8.2.2. シングルボリューム四面体 2次要素(samples/makefem3/2ji_single_tetra/) 

サンプルを BcGUI で表示した画面を図 8.2-2 に示します。 
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図 8.2-2 シングルボリューム四面体 2 次要素のサンプルの形状 

 

入力ファイル 

model/Solid.msh シングルボリューム四面体 2 次要素のメッシュデータファイル 

model/Solid_2.0.fgr メッシュ表面データファイル 

model/Solid_2.0.pcg 表面パッチグループデータファイル 

   (makefem3 では使用しません) 

model/Solid_2.0.pch 表面メッシュグループ抽出データファイル 

   (makefem3 では使用しません) 

model/Solid_2.0.trn グローバルインデックスファイル 

model/Solid_mp.dat 物性値ファイル 

cnd/all.cnd 解析条件ファイル(※すべての解析条件を含むわけではありません) 

nonlinear.cnd 解析条件ファイル 

normal.cnd 解析条件ファイル 

transient.cnd 解析条件ファイル 

出力ファイル 

result.adv 

 

8.2.3. シングルボリューム六面体 1次要素(samples/makefem3/1ji_single_hexa/) 

サンプルを BcGUI で表示した画面を図 8.2-3 に示します。 
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図 8.2-3 シングルボリューム六面体 1 次要素のサンプルの形状 

 

入力ファイル 

model/testCylinder_1ji_single.msh シングルボリューム六面体 1 次要素のメッシュデータ

ファイル 

model/testCylinder_1ji_single_4.fgr メッシュ表面データファイル 

model/testCylinder_1ji_single_4.pcg 表面パッチグループデータファイル 

    (makefem3 では使用しません) 

model/testCylinder_1ji_single_4.pch 表面メッシュグループ抽出データファイル 

    (makefem3 では使用しません) 

model/testCylinder_1ji_single_4.trn グローバルインデックスファイル 

model/s_material.dat 物性値ファイル 

cnd/all.cnd 解析条件ファイル(※すべての条件を含むわけではありません) 

出力ファイル 

result.adv 

 

8.2.4. シングルボリューム六面体 2次要素(samples/makefem3/2ji_single_hexa/) 

サンプルを BcGUI で表示した画面を図 8.2-4 に示します。 
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図 8.2-4 シングルボリューム六面体 2 次要素のサンプルの形状 

 

入力ファイル 

model/testCylinder_2ji_single.msh シングルボリューム六面体 2 次要素のメッシュデータ

ファイル 

model/testCylinder_2ji_single_4.fgr メッシュ表面データファイル 

model/testCylinder_2ji_single_4.pcg 表面パッチグループデータファイル 

    (makefem3 では使用しません) 

model/testCylinder_2ji_single_4.pch 表面メッシュグループ抽出データファイル 

    (makefem3 では使用しません) 

model/testCylinder_2ji_single_4.trn グローバルインデックスファイル 

model/s_material.dat 物性値ファイル 

cnd/all.cnd 解析条件ファイル(*すべての条件を含むわけではありません) 

出力ファイル 

result.adv 

 

8.2.5. マルチボリューム四面体 1次要素(samples/makefem3/1ji_multi_tetra/) 

サンプルを BcGUI で表示した画面を図 8.2-5 に示します。 
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図 8.2-5 マルチボリューム四面体 1 次要素のサンプルの形状 

 

入力ファイル 

model/single.msh シングルボリューム四面体 1 次要素のメッシュデータファイル 

model/multi_2.fgr メッシュ表面データファイル 

model/multi_2.pcg 表面パッチグループデータファイル 

   (makefem3 では使用しません) 

model/multi_2.pch 表面メッシュグループ抽出データファイル 

   (makefem3 では使用しません) 

model/multi_2.trn グローバルインデックスファイル 

model/m_material.dat 物性値ファイル 

cnd/all.cnd 解析条件ファイル(*すべての条件を含むわけではありません) 

出力ファイル 

result.adv 

 

8.2.6. マルチボリューム四面体 2次要素(samples/makefem3/2ji_multi_tetra/) 

サンプルを BcGUI で表示した画面を図 8.2-6 に示します。 
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図 8.2-6 マルチボリューム四面体 2 次要素のサンプルの形状 

 

入力ファイル 

model/single.msh シングルボリューム四面体 1 次要素のメッシュデータファイル 

model/multi_2.fgr メッシュ表面データファイル 

model/multi_2.pcg 表面パッチグループデータファイル 

   (makefem3 では使用しません) 

model/multi_2.pch 表面メッシュグループ抽出データファイル 

   (makefem3 では使用しません) 

model/multi_2.trn グローバルインデックスファイル 

model/m_material.dat 物性値ファイル 

cnd/all.cnd 解析条件ファイル(※すべての条件を含むわけではありません) 

出力ファイル 

result.adv 

 

8.2.7. マルチボリューム六面体 1次要素(samples/makefem3/1ji_multi_hexa/) 

サンプルを BcGUI で表示した画面を図 8.2-7 に示します。 
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図 8.2-7 マルチボリューム六面体 1 次要素のサンプルの形状 

 

入力ファイル 

model/testCylinder_1ji_multi.msh シングルボリューム六面体 1 次要素のメッシュデータ

ファイル 

model/testCylinder_1ji_multi_4.fgr メッシュ表面データファイル 

model/testCylinder_1ji_multi_4.pcg 表面パッチグループデータファイル 

    (makefem3 では使用しません) 

model/testCylinder_1ji_multi_4.pch 表面メッシュグループ抽出データファイル 

    (makefem3 では使用しません) 

model/testCylinder_1ji_multi_4.trn グローバルインデックスファイル 

model/m_material.dat 物性値ファイル 

cnd/all.cnd 解析条件ファイル(※すべての条件を含むわけではありません) 

出力ファイル 

result.adv 

 

8.2.8. マルチボリューム六面体 2次要素(samples/makefem3/2ji_multi_hexa/) 

サンプルを BcGUI で表示した画面を図 8.2-8 に示します。 
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図 8.2-8 マルチボリューム六面体 2 次要素のサンプルの形状 

 

入力ファイル 

model/testCylinder_2ji_multi.msh マルチボリューム六面体 2 次要素のメッシュデータフ

ァイル 

model/testCylinder_2ji_multi_4.fgr メッシュ表面データファイル 

model/testCylinder_2ji_multi_4.pcg 表面パッチグループデータファイル 

    (makefem3 では使用しません) 

model/testCylinder_2ji_multi_4.pch 表面メッシュグループ抽出データファイル 

    (makefem3 では使用しません) 

model/testCylinder_2ji_multi_4.trn グローバルインデックスファイル 

model/m_material.dat 物性値ファイル 

cnd/all.cnd 解析条件ファイル(※すべての条件を含むわけではありません) 

出力ファイル 

result.adv 

 
8.3. csv2adv 

サンプルファイル 

・入力  

 1-1.csv  

 1-2.csv  

 1-3.csv  

・出力  

 test1.a  

 

・入力  

 2-1.csv  

 2-2.csv  

 2-3.csv  

・出力  

 なし  
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・入力  

 3-1.csv  

 3-2.csv  

 3-3.csv  

・出力  

 test3.a    

 

 実行例  

・入力ファイルが 1 つの場合  

% csv2adv.pl result.a bc_timehistory.csv  

   

・入力ファイルが 3 つの場合  

% csv2adv.pl result.a 1-1.csv 1-2.csv 1-3.csv 

 

8.4. 熱解析 

8.4.1. 温度規定境界条件(samples/Thermal/test_temp_only) 

サンプルを BcGUI で表示したものを図 8.4-1 に示します。赤い面グループが温度境界条

件を設定した面グループをそれぞれ示しています。 

 

 
図 8.4-1 温度規定境界条件用サンプル 

 

入力ファイル 

requestModelc.msh:  メッシュファイル 

requestModelc_3.fgr:  メッシュ表面データファイル 

requestModelc_3.cnd:  解析条件ファイル 

requestModelc_3.dat:  物性値ファイル 

requestModelc_3.trn:  グローバルインデックスファイル 

出力ファイル 

requestModel.adv:  一体型入力ファイル 

 

8.4.2. 熱流束規定境界条件(samples/Thermal/test_heatflux) 

サンプルを BcGUI で表示したものを図 8.4-2 に示します。赤い面グループが温度規定境

界条件を、黄色い面グループが熱流束規定境界条件を、それぞれ設定した面グループを示
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しています。 

 

 
図 8.4-2 熱流束規定境界条件用サンプル 

 

入力ファイル 

requestModelc.msh:  メッシュファイル 

requestModelc_3.fgr:  メッシュ表面データファイル 

requestModelc_3.cnd:  解析条件ファイル 

requestModelc_3.dat:  物性値ファイル 

requestModelc_3.trn:  グローバルインデックスファイル 

出力ファイル 

requestModel.adv:  一体型入力ファイル 

 

8.4.3. 熱伝達規定境界条件(samples/Thermal/test_heattransfer) 

サンプルを BcGUI で表示したものを図 8.4-3 に示します。赤い面グループが温度規定境

界条件を、薄桃色の面グループが熱伝達規定境界条件を、それぞれ設定した面グループを

示しています。 
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図 8.4-3 熱伝達規定境界条件用サンプル 

 

入力ファイル 

requestModelc.msh:  メッシュファイル 

requestModelc_3.fgr:  メッシュ表面データファイル 

requestModelc_3.cnd:  解析条件ファイル 

requestModelc_3.dat:  物性値ファイル 

requestModelc_3.trn:  グローバルインデックスファイル 

出力ファイル 

requestModel.adv:  一体型入力ファイル 

 

8.4.4. 熱ふく射規定境界条件(samples/Thermal/test_heatradiation) 

サンプルを BcGUI で表示したものを図 8.4-4 に示します。赤い面グループが温度規定境

界条件を、ピンク色の面グループが熱ふく射規定境界条件を、それぞれ設定した面グルー

プを示しています。 

 

 
図 8.4-4 熱ふく射規定境界条件用サンプル 
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入力ファイル 

requestModelc.msh:  メッシュファイル 

requestModelc_3.fgr:  メッシュ表面データファイル 

requestModelc_3.cnd:  解析条件ファイル 

requestModelc_3.dat:  物性値ファイル 

requestModelc_3.trn:  グローバルインデックスファイル 

出力ファイル 

requestModel.adv:  一体型入力ファイル 

 
8.5. PcmMerge 

8.5.1. ナット 2個 

以下のファイルがサンプルとして用意されています。 

PcmMerge 入力ファイル 

 samples/PcmMerge/doubleNut/lowerNut-2mm.pch 

 samples/PcmMerge/doubleNut/upperNut-2mm.pch 

 

lowerNut-2mm.pchとupperNut-2mm.pchの座標範囲はそれぞれ(-5, -4.33, 0)～(5, 4.33, 

5)と(-5, -4.33, 6)～(5, 4.33, 11)です。形状をそれぞれ、図 8.5-1 と図 8.5-2 に示します。 

 

 
図 8.5-1 lowerNut-2mm.pch の形状 
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図 8.5-2 upperNut-2mm.pch の形状 

 

名前から分かるように、lowerNut が upperNut の下にあり、両者は接しています。

lowerNut-2mm.pch の方を pcmFileA として指定して、下の PcmMerge.sh コマンドを実

行します。 

% PcmMerge.sh lowerNut-2mm.pch upperNut-2mm.pch 

すると次の 2 個の PcmMerge 出力ファイルが出力されます。 

 samples/PcmMerge/doubleNut/out.pcm 

 samples/PcmMerge/doubleNut/moveInfo.dat 

 

図 8.5-3 に out.pcm の形状を示します。lowerNut と upperNut をマージした形状となっ

ております。 
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図 8.5-3 lowerNut と upperNut をマージした形状 

 

上にリストアップはしませんでしたが、それ以外に、modelA.pcm、modelA.pcg、

modelB.pcm、modelB.pcg、out.pcg 及び out.wrl も副産物として生成されます。 

次に advtmesh9p コマンドで表面パッチを修正します。 

% advtmesh9p out -base1. -p 

すると以下の 3 つのファイルが、AdvTetMesh_P の出力ファイルとして作成されます。 

 samples/PcmMerge/doubleNut/outc.pcc 

 samples/PcmMerge/doubleNut/outc.ptn 

 samples/PcmMerge/doubleNut/out_c.wrl 

 

次に、advtmesh9m コマンドで四面体一次要素を生成します。 

% advtmesh9m outc -p 

すると以下の 3つのファイルが、AdvTetMesh_Mの出力ファイルとして作成されます。 

 samples/PcmMerge/doubleNut/outc.msh 

 samples/PcmMerge/doubleNut/outc_e.wrl 

 samples/PcmMerge/doubleNut/outc_n.wrl 

 

次に advtmesh9s コマンドで四面体二次要素を生成します。 

% advtmesh9s outc 

すると以下の一つのファイルが、AdvTetMesh_S の出力ファイルとして作成されます。 

 samples/PcmMerge/doubleNut/outcs.msh 

 

下の MergeCheck コマンドでは、四面体一次要素メッシュの融合した節点を分離します。 

% MergeCheck outc.msh moveInfo.dat doubleNutOutLinear 

すると 3 つの MergeCheck の出力ファイルが生成されます。 

 samples/PcmMerge/doubleNut/doubleNutOutLinear.msh 

 samples/PcmMerge/doubleNut/doubleNutOutLinear.np 
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 samples/PcmMerge/doubleNut/doubleNutOutLinear.nv 

それぞれボリューム間境界節点が分離された 2 ボリューム四面体一次要素メッシュファ

イル、境界面の対応する節点ペアリストファイルと境界面上の各節点における法線ベクト

ルファイルです。 

 

下の MergeCheck コマンドでは、四面体二次要素メッシュの融合節点を分離します。 

% MergeCheck outcs.msh moveInfo.dat doubleNutOutQuadratic 

すると 3 つの MergeCheck の出力ファイルが生成されます。 

 samples/PcmMerge/doubleNut/ doubleNutOutQuadratic.msh 

 samples/PcmMerge/doubleNut/ doubleNutOutQuadratic.np 

 samples/PcmMerge/doubleNut/ doubleNutOutQuadratic.nv 

それぞれボリューム間境界節点が分離された 2 ボリューム四面体二次要素メッシュファ

イル、境界面の対応する節点ペアリストファイルと境界面上の各節点における法線ベクト

ルファイルです。 

 

8.5.2. 円盤上の直方体 

以下のファイルがサンプルとして用意されています。 

PcmMerge 入力ファイル 

 samples/PcmMerge/brickOnDisk/body1.pcm 

 samples/PcmMerge/brickOnDisk/contact/body2Contact.pcm 

 samples/PcmMerge/brickOnDisk/interfere/body2Interfere.pcm 

 samples/PcmMerge/brickOnDisk/separate/body2Separate.pcm 

 

body1.pcm、body2Contact.pcm、body2Interfere.pcm 及び body2Separate.pcm の座標

範囲はそれぞれ(-4, -4, 0)～(4, 4, 3)、(-1, -2, 3)～(1, 2, 6)、(-1, -2, 2.9)～(1, 2, 6)及び(-1, -2, 

3.5)～(1, 2, 6)です。形状を図 8.5-4～図 8.5-7 に示します。 

 

 
図 8.5-4 body1.pcm の形状 
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図 8.5-5 body2Contact.pcm の形状 

 

 
図 8.5-6 body2Interfere.pcm の形状 
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図 8.5-7 body2Separate.pcm の形状 

 

body1.pcm と body2Contact.pcm と は 接 し て い ま す 。 フ ォ ル ダ

samples/PcmMerge/brickOnDisk/contact/ で次のコマンドを実行すると 

% PcmMerge ../body1.pcm body2Contact.pcm 

次の 2 個のファイルプラス 6 個の副産物ファイルが出力されます。 

 samples/PcmMerge/brickOnDisk/contact/out.pcm 

 samples/PcmMerge/brickOnDisk/contact/moveInfo.dat 

 

図 8.5-8 に out.pcm の形状を示します。body1 と body2Contact をマージした形状となって

おります。 
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図 8.5-8 初期形状が接触する場合の out.pcm の形状 

 

body1.pcm と body2Interfere.pcm とは z= 2.9～3 の範囲で干渉しています。フォルダ

samples/brickOnDisk/interfere/ で次のコマンドを実行すると 

% PcmMerge ../body1.pcm body2Interfere.pcm 

次の 2 個のファイルプラス 6 個の副産物ファイルが出力されます。 

 samples/PcmMerge/brickOnDisk/interfere/out.pcm 

 samples/PcmMerge/brickOnDisk/interfere/moveInfo.dat 

 

out.pcm の形状は図 8.5-8 とそっくりですが干渉はしてません。 

 

body1.pcm と body2Separate.pcm とは z= 3～3.5 の範囲でギャップがあります。フォル

ダ samples/PcmMerge/brickOnDisk/separate/ で次のコマンドを実行すると 

% PcmMerge ../body1.pcm body2Separate.pcm 

次の 2 個のファイルプラス 6 個の副産物ファイルが出力されます。 

 samples/PcmMerge/brickOnDisk/separate/out.pcm 

 samples/PcmMerge/brickOnDisk/separate/moveInfo.dat 

 

out.pcm の形状はギャップがふさがれているため、図 8.5-9 に示すとおり図 8.5-8 より少

し背が低いです。 
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図 8.5-9 初期形状が離れている場合の out.pcm の形状 

 

contact、interfere、separate の各フォルダで四面体生成を行います。即ち 
% advtmesh9p out -base1. -p 

% advtmesh9m outc -p 

二次要素を生成するときは、 
% advtmesh9s outc 

も実行します。各フォルダに 

 outc.pcc 

 outc.ptn 

 out_c.wrl 

 outc.msh 

 outc_e.wrl 

 outc_n.wrl 

 outcs.msh 

が生成されます。 

 

contact、interfere、separateの各フォルダで、MergeCheckコマンドを実行し、四面体

二次要素メッシュの融合した節点を分離します。 
% MergeCheck outcs.msh moveInfo.dat brickOnDiskOutQuadratic 

すると 3 つの MergeCheck の出力ファイルが生成されます。 

 brickOnDiskOutQuadratic.msh 

 brickOnDiskOutQuadratic.np 

 brickOnDiskOutQuadratic.nv 
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図 8.5-10 に contact の場合の brickOnDiskOutQuadratic.msh を表示します。二つのボ

リュームは接触しています。 

 
図 8.5-10 初期形状が接触している場合の brickOnDiskOutQuadratic.msh の形状 

 

図 8.5-11 に interfere の場合の brickOnDiskOutQuadratic.msh を表示します。二つの

ボリュームは接触しています。 

 
図 8.5-11 初期形状が干渉している場合の brickOnDiskOutQuadratic.msh の形状 
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図 8.5-12 に separate の場合の brickOnDiskOutQuadratic.msh を表示します。元の通

り二つのボリュームが分離されてます。 

 
図 8.5-12 初期形状が離れている場合の brickOnDiskOutQuadratic.msh の形状 

 

8.6. MpcMasterSlaveTool 
8.6.1. 2box 

接触する二つの大きさの異なる立方体のサンプルです。 

 

メッシュファイル合成 

MPC_mshmrg を用いて、予め用意されたメッシュファイル leftc.msh, rightc.msh を元

に MPC_merged.msh を合成します。ここでは、 
% MPC_mshmrg.pl leftc.msh rightc.msh 

と入力すると、合成されたメッシュファイル MPC_merged.msh が出力されます。

MPC_merged.msh の形状を図 8.6-1 に示します。図 8.6-1 の小さい立方体が leftc.msh 由

来、大きい立方体が rightc.msh 由来の部分になります。 

 

 
図 8.6-1 2box の MPC_merged.msh の形状 

 

メッシュの表面の抽出 

msh2pch を用いて、MPC_merged.msh を元にメッシュの表面を抽出及びグループ化し、

GUI の入力フォーマットへ変換します。ここでは、メッシュファイル名を
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MPC_merged.msh 、2 面狭角を 60(=180/3)度として、 
% msh2pch MPC_merged.msh 3 

と入力します。以下のファイルが出力されます。 

 MPC_merged_3.fgr：メッシュ表面データファイル 

 MPC_merged_3.pch：表面メッシュ抽出データファイル 

 MPC_merged_3.pcg：表面パッチグループデータファイル 

 MPC_merged_3.trn：グローバルインデックスファイル 

 

MPC 作成 

MPC_assem2 を用いて、メッシュファイル、メッシュ表面データファイル及び cmb フ

ァイルを元に節点座標の異なる面を結合するMPC を出力します。このとき、面グループ 5

と 8 の 1 組をペアとして、combi.cmb ファイルを作成しておきます。ここでは、 
% MPC_assem2 MPC_merged.msh MPC_merged_3.fgr combi.cmb > 

MPC_merged_3.mpc 

と入力し、テキストエディタで MPC_merged_3.mpc の行数を調べて先頭に

「LinearConstraint 行数」を書きます。 

 

a2adv による Adv ファイル作成 

a2adv.plを用いて、MPCファイルを元に ADVENTURE_IO 形式の一体型解析モデルフ

ァイルを出力します。ここでは、 
% a2adv.pl MPC_merged_3.mpc LinearConstraint.adv 

と入力します。LinearConstraint.adv が出力されます。 

 

境界条件の設定（荷重、拘束） 

BcGUI 2.0 を用いて、境界条件を設定します。境界条件を設定したい節点または面グル

ープを選択し、メニューから「BC->BC(Solid)->Add SurfaceTraction」(荷重設定)または

「BC->BC(Solid)->Add Displacement」(拘束または強制変位)を選択すると、境界条件設

定ダイアログが表示されます。ここでは、図 8.6-2 に示した面グループ 11 を選択し、メニ

ューから「BC->BC(Solid)->Add SurfaceTraction」を選択します。そして、ダイアログの

"X"の左にあるチェックボタンを選択し、その右にあるテキストボックスに"10"と入力して

"OK"ボタンをクリックします(面グループ番号 11 に、X 方向に、強さ 10 の荷重を負荷)。

同様に、図 8.6-3 に示した面グループ 2 を選択し、メニューから「BC->BC(Solid)->Add 

Displacement」を選択して、"X", ”Y”, ”Z”の左にあるチェックボタンを選択し、その右の

テキストボックスには全て"0"を入力します(面グループ番号 2 の変位を全方向拘束)。 
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図 8.6-2 面グループ 11 の選択及び荷重条件の設定 

 

 
図 8.6-3 面グループ 2 の選択及び変位拘束条件の設定 
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物性値設定 

物性値ファイルをテキストエディタで作成します。ここでは、ファイル名を

MPC_merged_3.mat とし、ヤング率 21000.0、ポアソン比 0.3 として、 

YoungModulus 21000.0 

PoissonRatio 0.3 

と入力します。 

 

makefem3 による Adv ファイル作成 

makefem3 を 用 い て、 メ ッ シ ュ に 対 し て境 界 条 件 と 物 性 値 を貼 り 付 け 、

ADVENTURE_IO 形式の一体型解析モデルファイルを作成します。ここでは 
% makefem3 MPC_merged.msh MPC_merged_3.fgr MPC_merged_3.cnd 

MPC_merged_3.mat MPC_merged_3.adv –t MPC_merged_3.trn 

と入力します。 

 

Adv ファイル合成 

advcat を用いて、a2adv と makefem で作成した Adv ファイルを合成します。ここでは、 
% advcat MPC_merged_3.adv LinearConstraint.adv 2box.adv 

と入力します。test_merged.adv が出力されます。 

 
8.6.2. bigplate 

大きな二枚の板の間に九本の直方体の柱が接触するサンプルです。 

 

メッシュファイル合成 
% MPC_mshmrg.pl platecs.msh columncs.msh 

出力された MPC_merged.msh の形状を図 8.6-4 に示します。図 8.6-4 の大きな二枚の板

が platecs.msh 由来、九本の直方体の柱が columncs.msh 由来の部分になります。 

 
図 8.6-4 bigplate の MPC_merged.msh の形状 
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メッシュの表面の抽出 
% msh2pch MPC_merged.msh 3 

 

MPC 作成 

combi.cmb に記述する面グループのペアは、2 と 27、2 と 51、2 と 57、2 と 21、2 と

45、2 と 63、2 と 15、2 と 33、2 と 39、9 と 25、9 と 49、9 と 55、9 と 19、9 と 42、9

と 61、9 と 12、9 と 31、9 と 37 の 18 組です。 
% MPC_assem2 MPC_merged.msh MPC_merged_3.fgr combi.cmb > 

MPC_merged_3.mpc 

MPC_assem2を実行後、MPC_merged_3.mpcの行数を調べて先頭に LinearConstraint 

行数を書きます。 

 

a2adv による Adv ファイル作成 
% a2adv.pl MPC_merged_3.mpc LinearConstraint.adv 

 

境界条件の設定（荷重、拘束） 
% BcGUI MPC_merged_3.pch MPC_merged_3.pcg –ocnd MPC_merged_3.cnd 

図 8.6-5、図 8.6-6 に示したように境界条件を設定します。 

 

 
図 8.6-5 面グループ 3 の選択及び強制変位条件の設定 
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図 8.6-6 面グループ 8 の選択及び変位拘束条件の設定 

 

物性値設定 

ヤング率 21000.0、ポアソン比 0.3 として、MPC_merged_3.mat を作成します。 

 

makefem による Adv ファイル作成 
% makefem3 MPC_merged.msh MPC_merged_3.fgr MPC_merged_3.cnd 

MPC_merged_3.mat MPC_merged_3.adv –t MPC_merged_3.trn 

 

Adv ファイル合成 
% advcat MPC_merged_3.adv LinearConstraint.adv bigplate.adv 

 
8.6.3. plate 

二枚の板の間に九本の直方体の柱が接触するサンプルです。 

 

メッシュファイル合成 

% MPC_mshmrg.pl platecs.msh columncs.msh 

出力された MPC_merged.msh の形状を図 8.6-7 に示します。図 8.6-7 の二枚の板が

platecs.msh 由来、九本の直方体の柱が columncs.msh 由来の部分になります。 
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図 8.6-7 plate の MPC_merged.msh の形状 

 

メッシュの表面の抽出 
% msh2pch MPC_merged.msh 3 

 

MPC 作成 

combi.cmbに記述する面グループのペアは 2と 29、2と 53、2と 59、2と 23、2と 47、

2 と 65、2 と 17、2 と 35、2 と 41、9 と 27、9 と 50、9 と 55、9 と 20、9 と 44、9 と

60、9 と 15、9 と 32、9 と 38 の 18 組です。 
% MPC_assem2 MPC_merged.msh MPC_merged_3.fgr, combi.cmb > 

MPC_merged_3.mpc 

MPC_assem2 実行後、MPC_merged_3.mpc の行数を調べて先頭に”LinearConstraint 

行数”を追記します。 

 

a2adv による Adv ファイル作成 
% a2adv.pl MPC_merged_3.mpc LinearConstraint.adv 

 

境界条件の設定（強制変位、変位） 
% BcGUI MPC_merged_3.pch MPC_merged_3.pcg –ocnd MPC_merged_3.cnd 

図 8.6-8、図 8.6-9 に示したように境界条件を設定します。 
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図 8.6-8 面グループ 3 の選択及び強制変位条件の設定 

 

 
図 8.6-9 面グループ 8 の選択及び変位拘束条件の設定 
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物性値設定 

ヤング率 21000.0、ポアソン比 0.3 として、MPC_merged_3.mat を作成します。 

 

makefem による Adv ファイル作成 
% makefem3 MPC_merged.msh MPC_merged_3.fgr MPC_merged_3.cnd 

MPC_merged_3.mat MPC_merged_3.adv –t MPC_merged_3.trn 

 

Adv ファイル合成 
% advcat MPC_merged_3.adv LinearConstraint.adv plate.adv 

 
8.6.4. Tassem 

T 字木材に二つの補強材が接触したサンプルです。 

 

メッシュファイル合成 
% MPC_mshmrg.pl Tpole.msh Rstrengthen.msh Lstrengthen.msh 

出力された MPC_merged.msh の形状を図 8.6-10 に示します。図 8.6-10 の T 字型が

Tpole.msh 由来、手前側の補強材が Rstrengthen.msh 由来、奥側の補強材が

Lstrengthen.msh 由来の部分になります。 

 
図 8.6-10 Tassemの MPC_merged.msh の形状 
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メッシュの表面の抽出 
% msh2pch MPC_merged.msh 3 

 

MPC 作成 

combi.cmb に記述する面グループのペアは 7 と 11、5 と 29、8 と 17、3 と 21 の 4 組で

す。 
% MPC_assem2 MPC_merged.msh MPC_merged_3.fgr combi.cmb > 

MPC_merged_3.mpc 

MPC_merged_3.mpc の行数を調べて先頭に LinearConstraint 行数を書きます。 

 

a2adv による Adv ファイル作成 
% a2adv.pl MPC_merged_3.mpc LinearConstraint.adv 

 

境界条件の設定（荷重、拘束） 
% BcGUI MPC_merged_3.pch MPC_merged_3.pcg –ocnd MPC_merged_3.cnd 

図 8.6-11 と図 8.6-12 に示したように境界条件を設定します。 

 

 
図 8.6-11 面グループ 6 の選択及び荷重条件の設定 
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図 8.6-12 面グループ 1 の選択及び変位拘束条件の設定 

 

物性値設定 

ヤング率 21000.0、ポアソン比 0.3 として、MPC_merged_3.mat を作成します。 

 

makefem による Adv ファイル作成 
% makefem3 MPC_merged.msh MPC_merged_3.fgr MPC_merged_3.cnd 

MPC_merged_3.mat MPC_merged_3.adv –t MPC_merged_3.trn 

 

Adv ファイル合成 
% advcat MPC_merged_3.adv LinearConstraint.adv Tassem.adv 
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8.7. a2adv 
8.7.1. cube.dat 

六面体 1 次要素のメッシュで、形状は立方体（図 8.7-1）です。総要素数は 64、総節点

数は 125です。強制変位境界条件データ数は 75で、z=0 の面（底面）を完全拘束していま

す。節点荷重境界条件データ数は 25 で、z=10 の面（上面）に z 方向-0.016 の強さの荷重

がかかっています。 

ヤング率は 21000.、ポアソン比は 0.4 を規定しています。座標値の範囲は(0, 0, 0)-(10, 

10, 10)です。 

 

 
図 8.7-1 cube.dat, cube.fem, cube.msh に記述されている立方体 

 

8.7.2. cube.fem 

六面体 1 次要素のメッシュで、形状は立方体（図 8.7-1）です。総要素数は 64、総節点

数は 125です。強制変位境界条件データ数は 75で、z=0 の面（底面）を完全拘束していま

す。節点荷重境界条件データ数は 25 で、z=10 の面（上面）に z 方向-0.016 の強さの荷重

がかかっています。座標値の範囲は(0, 0, 0)-(10, 10, 10)です。 

  
8.7.3. cube.msh 

六面体 1 次要素のメッシュで、形状は立方体（図 8.7-1）です。 

総要素数は 64、総節点数は 125 です。座標値の範囲は(0, 0, 0)-(10, 10, 10)です。 

 
8.7.4. TypeV.mpc 

一般的な MPC 拘束条件を記載しています。MPCRHS は各条件式の右辺の値です。 

 
8.7.5. conditions1.dat 

ヤング率は 21000.、ポアソン比は 0.4 を規定しています。 
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8.7.6. conditions2.dat 

強制変位境界条件データ数は 75 で、z=0 の面（底面）を完全拘束しています。節点荷重

境界条件データ数は 25 で、z=10 の面（上面）に z 方向-0.016 の強さの荷重がかかってい

ます。ヤング率は 21000.、ポアソン比は 0.4 を規定しています。 

 
8.7.7. conditions-temp.dat 

熱応力解析の条件データです。熱膨張率は 4.2941×10-6 で、参照温度は 300.0 です。各

節点での温度が与えられています。 

 
8.7.8. multi-material.dat 

強制変位境界条件データ数は 75 で、z=0 の面（底面）を完全拘束しています。節点荷重

境界条件データ数は 25 で、z=10 の面（上面）に z 方向-0.016 の強さの荷重がかかってい

ます。 

マテリアル ID0 のヤング率は 21000.、ポアソン比は 0.4 と規定しています。 

マテリアル ID1 のヤング率は 71600.、ポアソン比は 0.345 と規定しています。 

各要素のマテリアル ID が与えられています。 

 
8.7.9. unknownlabel.dat 

六面体 1 次要素のメッシュで、形状は立方体です。 

総要素数は 1、総節点数は 8 です。座標値の範囲は(0, 0, 0)-(1, 1, 1)です。 

リスト 8.7-1 はプログラム中に定義されていない FEGA をデータファイル中で定義して

いるサンプルです。 

 

リスト 8.7-1 FEGA 定義サンプルファイル 

############################################################### 

UnknownFEGA_A   1       # FEGA not defined in a2adv 

############################################################### 

fega_type=AllElementConstant 

format=f8 

 

  3.0 

 

############################################################### 

UnknownFEGA_B   2       # FEGA not defined in a2adv 

############################################################### 

fega_type=NodeVariable 

format=f8 

 

  3  9.0 

 10  0.0 

9.2.1 節に説明している通り、fega_type と format をデータファイル中に定義します。

UnknownFEGA_A はラベルで、データ数が１個です。fega_type で FEGA の種類を規定

して、format で数値の並びと型を規定しています。UnknownFEGA_B も同様です。 

 
8.7.10. unknownlabel.msh 

六面体 1 次要素のメッシュで、形状は立方体です。 

総要素数は 1、総節点数は 8 です。座標値の範囲は(0, 0, 0)-(1, 1, 1)です。 
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8.7.11. qring 

大きな輪の内側に小さな輪が接触するものを四等分したサンプルです。 

 

メッシュファイル合成 
% MPC_mshmrg.pl qring.msh qouter.msh 

出力された MPC_merged.msh の形状を図 8.7-2 に示します。図 8.7-2 の大きな輪が

qouter.msh 由来、内側の小さな輪が qring.msh 由来の部分になります。 

 
図 8.7-2 qring の MPC_merged.msh の形状 

 

メッシュの表面の抽出 
% msh2pch MPC_merged.msh 3 

 

MPC 作成 

combi.cmb に記述する面グループのペアは 11 と 0 の 1 組です。 
% MPC_assem2 MPC_merged.msh MPC_merged_3.fgr combi.cmb > 

MPC_merged_3.mpc 

MPC_merged_3.mpc の行数を調べて先頭に LinearConstraint 行数を書きます。 

 

a2adv による Adv ファイル作成 
% a2adv.pl MPC_merged_3.mpc LinearConstraint.adv 

 

境界条件の設定（圧力、対称条件、拘束） 
% BcGUI MPC_merged_3.pch MPC_merged_3.pcg –ocnd MPC_merged_3.cnd 

図 8.7-3 から図 8.7-9 までに示したように境界条件を設定します。 
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図 8.7-3 面グループ 4 の選択及び圧力条件の設定 

 

 
図 8.7-4 面グループ 1 の選択及び対称条件の設定 
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図 8.7-5 面グループ 5 の選択及び対称条件の設定 

 

 
図 8.7-6 面グループ 6 の選択及び変位拘束条件の設定 
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図 8.7-7 面グループ 7 の選択及び変位拘束条件の設定 

 

 
図 8.7-8 面グループ 9 の選択及び対称条件の設定 
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図 8.7-9 面グループ 12 の選択及び対称条件の設定 

 

 

物性値設定 

ヤング率 21000.0、ポアソン比 0.3 として、MPC_merged_3.mat を作成します。 

 

makefem による Adv ファイル作成 
% makefem3 MPC_merged.msh MPC_merged_3.fgr MPC_merged_3.cnd 

MPC_merged_3.mat MPC_merged_3.adv –t MPC_merged_3.trn 

 

Adv ファイル合成 
% advcat MPC_merged_3.adv LinearConstraint.adv qring.adv 

 
8.8. MpcLocal2Global 
8.8.1. doubleNut.files 

入力ファイル 

 doubleNut.msh 

 Solid_2.0.pch 

 Solid_2.0.trn 

 Solid_2.0.pcg 

MPC 条件ファイル 

MpcTest.cnd:   剛体はり V 

MpcTest3.cnd:   剛体はり V 

MpcTest7.cnd:   剛体はり V 

出力ファイル 

 MpcTest3.mpc:   MptTest3.cnd からの出力 

 MpcTest4.mpc:   MptTest3.mpc を手で編集したもの 
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 MpcTest6.mpc:   MptTest4.mpc を手で編集したもの 

 MpcTest7.mpc:   MptTest7.cnd からの出力 

 

直接使用しないがソルバ実行のためには必要なファイル 

 doubleNutOutQuadratic.msh:  要素数 3330、節点数 6025 

 Solid_2.0.fgr:   メッシュ表面データファイル 

 Solid_2.0.cnd:   通常の境界条件 

 Solid_mp_multi.dat:  材料定数ファイル 

 Solid_2.0.adv:   一体型入力ファイル(除 MPC 条件) 

 

mpcGui のテストで作成した MPC 条件ファイル 

 MpcI_N.cnd:   剛体はり I 節点同士 

 MpcI_SG.cnd:   剛体はり I 面グループ同士 

 MpcII_N.cnd:   剛体はり II 節点同士 

 MpcII_SG.cnd:   剛体はり II 面グループ同士 

 MpcIII_N.cnd:   剛体はり III 節点同士 

 MpcIII_SG.cnd:   剛体はり III 面グループ同士 

 MpcIV_N.cnd:   剛体はり IV 節点同士 

 MpcIV_SG.cnd:   剛体はり IV 面グループ同士 

 MpcV_N.cnd:   剛体はり V 節点同士 

 MpcLM_N.cnd:   任意の MPC 節点同士 

 

8.8.2. doubleBeam.files 

入力ファイル 

 Solid_2.0.pch 

 Solid_2.0.trn 

 Solid_2.0.pcg 

 MPC 条件ファイル 

MpcI_N.cnd:   剛体はり I 節点同士 

直接使用しないがソルバ実行のためには必要なファイル 

 Solid.msh:   要素数 156、節点数 426 

 Solid_2.0.fgr:   メッシュ表面データファイル 

 Solid_2.0.cnd:   通常の境界条件 

 Solid_mp_multi.dat :  材料定数ファイル 

 Solid_2.0.adv:   一体型入力ファイル(除 MPC 条件) 

 

8.8.3. Test1 

入力ファイル 

 testCase1.pch:  でない場合 

 testCase2.pch:  かつの場合 

 testCase3.pch:  かつでない場合 

 testCase.trn 

 testCase_typeV.pcg 

 MpcSimplest.cnd  MPC 条件ファイル 
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8.8.4. Test2 

入力ファイル 

 doubleNut_2.0.pch 

 doubleNut_2.0.trn 

 doubleNut_2.0.pcg 

MpcTest7.cnd  MPC 条件ファイル 

 
8.8.5. doubleNut2010 

入力ファイル 

 Solid_2.0.pch 

 Solid_2.0.trn 

 Solid_2.0.pcg 

 Solid_2.0.msh 

 Solid_2.0.fgr 

 MPC 条件ファイル 

doubleNut2010/cndFile 下 

TypeI.cnd:  剛体はり I 

TypeII.cnd:  剛体はり II 

TypeIII.cnd:  剛体はり III 

TypeIV.cnd:  剛体はり IV 

TypeV.cnd:  剛体はり V 

SimpleBeam.cnd: 単純はり 

LinearMPC.cnd: 任意の MPC 

Mix.cnd:  剛体はり I～V、単純はり、任意の MPC の混合 

出力ファイル 

doubleNut2010/mpcFile 下 

 TypeI.mpc:  TypeI.cnd からの出力 

 TypeII.mpc:  TypeII.cnd からの出力 

 TypeIII.mpc:  TypeIII.cnd からの出力 

 TypeIV.mpc:  TypeIV.cnd からの出力 

 TypeV.mpc:  TypeV.cnd からの出力 

 SimpleBeam.mpc:  SimpleBeam.cnd からの出力 

 LinearMPC.mpc:  LinearMPC.cnd からの出力 

 Mix.mpc:   Mix.cnd からの出力 

 

直接使用しないがソルバ実行のためには必要なファイル 

 Solid_2.0.adv 
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9. Appendix C ファイルフォーマット 
9.1. 汎用解析データファイル(拡張子 aもしくは atx) 

ADVENTURE Format の FEGA Document に対応した構造を持つテキストファイルで

す。1 Document に対してリスト 9.1-1 のような構造を持ちます。詳しくは 9.2.1 を参照し

てください。 

リスト 9.1-1 atx ファイルの構造 

  [コンテントタイプ] [ラベル名|要素名]    [データ数] 

   [<key> = <val>] 

         . 

         . 

         . 

   data[0][0]   data[0][1]  ....   # <- 1 番目のデータ 

   data[1][0]   data[1][1]  ....   # <- 2 番目のデータ 

         . 

         . 

         . 

   data[n][0]   data[n][1]  ....   # <-  n(= データ数) 番目のデータ 

 

コンテントタイプは、Element(要素コネクティビティ)、Node(節点座標)、FEGA の 3

種類があり、 FEGA の場合は省略可能です。 

Element の場合は、要素名を書きます。Nodeの場合節点数を書きます。 

FEGA の場合、次にラベル名を書く必要があります。FEGA のラベル名とはたとえば、

節点荷重境界条件は "Load" というように、それぞれのデータ種類に対して決められた名

前です。データ数は、後に続くデータの行数であり、指定のない場合は 1 と見なされま

す。 

[<key> = <val>] の行は、このデータに対して付加情報を加えるのに用いるプロパティ

(ADVENTURE Format の Document の property )です。コンテントタイプやラベル名に

応じて、a2adv.pl での変換時に幾つかのプロパティが自動的に設定されますが、追加する

必要がある場合に指定します。 

その後、それぞれのラベル名で決められた個数のデータを、指定した[データ数]で指定

した行だけ繰り返します。ドキュメント中、文字 '#' はコメントのはじまりを示し、# 以降

行末まで無視されます。 また空白行は適当にあって良いです。 

 

a2adv がサポートするドキュメントは以下の通りです。i4 は(4 バイト)整数、f8 は(8 バ

イト)実数を示します。 

 

9.1.1. 節点ドキュメント 

プロパティ名 説明 

dimension 次元。3 固定 

format 1 行のデータ構造。f8f8f8 固定 

1 行のデータ構造は、x(f8) y(f8) z(f8) (節点座標)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type Node 固定 

num_items 節点の数 
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9.1.2. 要素ドキュメント 

プロパティ名 説明 

content_type 一体型ファイルでは Element 、領域分割ファイルでは

HDDM_Element 

element_type 四面体 1 次：3DLinearTetrahedon 

四面体 2 次：3DQuadraticTetrahedon 

六面体 1 次：3DLinearHexahedon 

六面体 2 次：3DQuadraticHexahedon 

num_nodes_per_element 1 要素あたりの節点数 

format 1 行のデータ構造。i4 を num_nodes_per_element だけ繰り返

す。 

dimension 次元。3 固定 

index_byte 4 固定 

1行のデータ構造においては、節点 ID(i4)がnum_nodes_per_elementだけ繰り返されて

います。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

num_items 要素の数 

 

9.1.3. FEGAドキュメント 

9.1.3.1. 境界条件 

・節点強制変位 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) 荷重値(f8)です。 

※方向の指定は全体座標系にて以下を指定します。 

x 軸 0 

y 軸 1 

z 軸 2 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。ForcedDisplacement 固定 

fega_type NodeVariable 固定 

 

・節点集中荷重 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) 荷重値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 
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プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。Load 固定 

fega_type NodeVariable 固定 

 

・要素面荷重 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

ElementFace 1の場合、ADV_Metis2で要素再分割に対応可能。 

1 行のデータ構造は、要素番号(i4) 面番号(i4) 方向(i4) 圧力値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。SurfaceLoad 固定 

fega_type ElementVariable 固定 

 

・速度 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) 荷重値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。ForcedVelocity 固定 

fega_type NodeVariable 固定 

 

・初期速度 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) 荷重値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。InitialVelocity 固定 

fega_type NodeVariable 固定 
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・加速度 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) 加速度値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。ForcedAcceleration 固定 

fega_type NodeVariable 固定 

 

・圧力 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、要素番号(i4) 面番号(i4) 圧力値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。Pressure 固定 

fega_type ElementVariable 固定 

ElementFace 1の場合、ADV_Metis2で要素再分割に対応可能。 

 

・圧力 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、要素番号(i4) 面番号(i4) 圧力値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。NeumanBC 固定 

fega_type NodeVariable 固定 
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・温度規定境界条件 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) 温度(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。Temperature 固定 

fega_type NodeVariable 固定 

 

・熱流束境界条件 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) 熱流束(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。HeatFlux 固定 

fega_type NodeVariable 固定 

 

・熱伝達境界条件 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

ElementFace 1の場合、ADV_Metis2で要素再分割に対応可能。 

1 行のデータ構造は、要素番号(i4) 面番号(i4) 外部接触温度(f8) 熱伝達係数(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。HeatConvection 固定 

fega_type ElementVariable 固定 
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・熱ふく射規定境界条件 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8f8f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

ElementFace 1の場合、ADV_Metis2で要素再分割に対応可能。 

1 行のデータ構造は、要素番号(i4) 面番号(i4) 放射源の温度(f8) 放射率(f8) 形状係数(f8)で

す。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。HeatRadiation 固定 

fega_type ElementVariable 固定 

 

・時間依存節点強制変位 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) history_id(i4) 荷重値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。TransientForcedDisplacement 固定 

fega_type NodeVariable 固定 

 

・時間依存節点集中荷重 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) history_id(i4) 荷重値(f8)です。 

※方向の指定は全体座標系にて以下を指定します。 

x 軸 0 

y 軸 1 

z 軸 2 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。TransientLoad 固定 

fega_type NodeVariable 固定 
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・時間依存要素面荷重 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

ElementFace 1の場合、ADV_Metis2で要素再分割に対応可能。 

1 行のデータ構造は、要素番号(i4) 面番号(i4) 方向(i4) history_id(i4) 圧力値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。TransientSurfaceLoad 固定 

fega_type ElementVariable 固定 

 

・時間依存速度 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) history_id(i4)荷重値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。TransientForcedVelocity 固定 

fega_type NodeVariable 固定 

 

・時間依存加速度 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4)history_id(i4) 加速度値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。TransientForcedAcceleration 固定 

fega_type NodeVariable 固定 
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・時間依存熱流束境界条件 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) history_id(i4) 熱流束(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。TransientHeatFlux 固定 

fega_type NodeVariable 固定 

 

・時間依存圧力 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、要素番号(i4) 面番号(i4) history_id(i4) 圧力値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。TransientPressure 固定 

fega_type ElementVariable 固定 

ElementFace 1の場合、ADV_Metis2で要素再分割に対応可能。 

 

・時間依存温度規定境界条件 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、節点番号(i4) 方向(i4) history_id(i4) 温度(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。TransientTemperature 固定 

fega_type NodeVariable 固定 
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・時間依存熱伝達境界条件 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

ElementFace 1の場合、ADV_Metis2で要素再分割に対応可能。 

1 行のデータ構造は、要素番号(i4) 面番号(i4) history_id(i4) 外部接触温度(f8) 熱伝達係数

(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。TransientHeatConvection 固定 

fega_type ElementVariable 固定 

 

・熱ふく射境界条件 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8f8f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

ElementFace 1の場合、ADV_Metis2で要素再分割に対応可能。 

1 行のデータ構造は、要素番号(i4) 面番号(i4) history_id(i4) 放射源の温度(f8) 放射率(f8) 

形状係数(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。TransientHeatRadiation 固定 

fega_type ElementVariable 固定 

 

・流速境界条件 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4f8 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、要素番号(i4) 面番号(i4) 圧力値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定する境界条件の数 

label ラベル名。DirichetBC 固定 

fega_type NodeVariable 固定 
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9.1.3.2. 物性値 

・物性 ID 

プロパティ名 説明 

format 1 行のデータ構造。i4 固定 

index_byte 4 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、物性 ID(i4)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 1 固定 

label ラベル名。MaterialID 固定 

fega_type AllElementVariable 固定 

 

・ヤング率 

プロパティ名 説明 

format 1 行のデータ構造。f8 固定 

material_id 適用対象となる部材の ID。省略された場合には 0 とみなす。 

index_byte 4 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 1 固定 

label ラベル名。YoungModulus 固定 

fega_type AllElementConstant 固定 

 

・ポアソン比 

プロパティ名 説明 

format 1 行のデータ構造。f8 固定 

material_id 適用対象となる部材の ID。省略された場合には 0 とみなす。 

index_byte 4 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 1 固定 

label ラベル名。PoissonRatio 固定 

fega_type AllElementConstant 固定 
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・加工硬化係数 

プロパティ名 説明 

format 1 行のデータ構造。f8 固定 

material_id 適用対象となる部材の ID。省略された場合には 0 とみなす。 

index_byte 4 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 1 固定 

label ラベル名。HardeningParameter 固定 

fega_type AllElementConstant 固定 

 

・初期降伏応力 

プロパティ名 説明 

format 1 行のデータ構造。f8 固定 

material_id 適用対象となる部材の ID。省略された場合には 0 とみなす。 

index_byte 4 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 1 固定 

label ラベル名。YieldStress 固定 

fega_type AllElementConstant 固定 

 

・質量密度 

プロパティ名 説明 

format 1 行のデータ構造。f8 固定 

material_id 適用対象となる部材の ID。省略された場合には 0 とみなす。 

index_byte 4 固定 

condition_id 境界条件セットの ID。省略された場合には 0 とみなす。 

1 行のデータ構造は、値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 1 固定 

label ラベル名。Density 固定 

fega_type AllElementConstant 固定 
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9.1.3.3. その他 

・一般的な MPC 拘束 

プロパティ名 説明 

index_byte 4 固定 

format 1 行のデータ構造。i4i4f8 固定 

1 行のデータ構造は、節点番号(i4) 方向(i4) MPC ID(i4) 係数値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 設定された MPC 条件の数 

label ラベル名。LinearConstraint 固定 

fega_type NodeVariable 固定 

 

・重力加速度ベクトル 

プロパティ名 説明 

format 1 行のデータ構造。f8f8f8 固定 

index_byte 4 固定 

1 行のデータ構造は、x(f8) y(f8) z(f8) (重力加速度の x y z 成分)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 1 固定 

label ラベル名。GravityAcceleration 固定 

fega_type AllElementConstant 固定 

 

・時刻歴 

プロパティ名 説明 

format 1 行のデータ構造。f8f8 固定 

1 行のデータ構造は、時刻(f8) 値(f8)です。 

 

一体型解析モデルファイルでは以下のプロパティが追加されます。 

プロパティ名 説明 

content_type FEGenericAttribute 固定 

num_items 時間刻みの個数 

label ラベル名。TimeHistory 固定 

fega_type Void 固定 
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9.2. 一体型解析モデルファイル(拡張子 adv) 

ADVENTURE_IO で読み書き可能なバイナリファイルです。 

 

9.2.1. ドキュメントの構造 

ADVENTURE_IO では、Documentと呼ばれるデータの単位を用いて入出力を行います。

一つのファイルの中には一つ以上の Document が含まれ、各 Document は以下の 3 つの構

成要素から成ります。 

 

・Document ID 

・Property 

・Raw Data 

 

Document ID はその Document を一意に指定するためのもので、ライブラリ関数を用い

て作成することができます。Property 部分にはその Document が何のデータなのかを意味

付けするものや、各プログラムに渡すオプションなどを指定します。指定方法は Key = 

Value という一対一の組み合わせを用います。Raw Data 部分には、種々の物理量や座標

値等のマスデータがバイナリ形式で格納されます。 

Document の意味付けには、"content_type"という key が使用されます。content_type

に は 標 準 的 な Element 、 Node 、 HDDM_Element 等 以 外 に 汎 用 的 な

FEGenericAttribute(FEGA)や HDDM_FEGenericAttribute が用意されています。FEGA 

は汎用的であるため、fega_typeと fega_formatの情報を記述してその内容を定義する必要

があります。 

BCtool がサポートするドキュメントは、9.1 に挙げたものです。 

 

9.3. メッシュデータファイル(拡張子msh) 

リスト 9.3-1 メッシュデータファイルのフォーマット(4 面体 1 次要素の場合) 

420   <- 要素の数  

171 116 117 99  <- 0 番目の要素を構成する節点  

145 132 172 156  <- 1 番目の要素を構成する節点  

145 105 132 156  

145 131 105 156  

130 110 131 156  

...(省略) ...  

72 63 60 74  

63 61 60 74  

63 62 61 74  

62 32 61 74  

62 33 32 74  <-(420-1) 番目の要素を構成する節点  

180   <- 節点の数  

2.5 -4.33013 0  <- 0 番目の節点の X,Y,Z 座標  

-2.5 -4.33013 0  <- 1 番目の節点の X,Y,Z 座標  

-5 0 0  

-2.5 4.33013 0  

2.5 4.33013 0 ^\ 

...(省略) ...  

0.173913 -4.33013 9.48837  

0.560861 -4.33013 7.98095  

3.73934 -2.18354 9.54426  

4.24419 -1.30912 8.32609  

3.49047 -2.61458 7.93914 <-(180-1) 番目の節点の X,Y,Z 座標  

2   <- ボリュームの数  



118 

 

210   <- 0 番目のボリュームに含まれる要素の数  

0   <- 0 番目のボリュームの 0 番目の要素  

複数材料の場合のみ 1   <- 0 番目のボリュームの 1 番目の要素  

...(省略) ...  

209   <- 0 番目のボリュームの(210-1) 番目の要素  

210   <- 1 番目のボリュームに含まれる要素の数 

210   <- 1 番目のボリュームの 0 番目の要素  

...(省略) ...  

419   <- 1 番目のボリュームの(210-1) 番目の要素 

*要素を構成する節点は  

 4 面体 1 次要素の場合は 4 個の節点を記述  

 4 面体 2 次要素の場合は 10 個の節点を記述  

 6 面体 1 次要素の場合は 8 個の節点を記述  

 6 面体 2 次要素の場合は 20 個の節点を記述面の情報  

 

要素を構成する節点の順番は以下のとおりです。  

 

4面体 

 
 

6面体 
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9.4. メッシュ表面データファイル(拡張子 fgr) 

リスト 9.4-1 メッシュ表面データファイルのフォーマット(4 面体 1 次要素の場合) 

8  <- 要素のタイプ* 

12  <- 面グループの数  

4  <- 0 番目の面グループを構成する面の数  

0 0 0 3 4 1 <- 0 番目の面グループの 0 番目の面の情報** 

2 0 3 6 7 4 <- 0 番目の面グループの 1 番目の情報  

1 0 1 4 5 2 <- 0 番目の面グループの 2 番目の情報  

3 0 4 7 8 5 <- 0 番目の面グループの 3 番目の情報  

4  <- 1 番目の面グループを構成する面の数  

0 2 0 1 10 9 <- 1 番目の面グループの 0 番目の面の情報  

1 2 1 2 11 10 <- 1 番目の面グループの 1 番目の面の情報  

4 2 9 10 19 18 <- 1 番目の面グループの 2 番目の面の情報  

5 2 10 11 20 19 <- 1 番目の面グループの 3 番目の面の情報  

...(省略) ...  

4  <-(12-1) 番目の面グループを構成する面の数  

12 1 45 46 49 48 <-(12-1) 番目の面グループの 0 番目の面の情報  

13 1 46 47 50 49 <-(12-1) 番目の面グループの 1 番目の面の情報  

14 1 48 49 52 51 <-(12-1) 番目の面グループの 2 番目の面の情報  

15 1 49 50 53 52 <-(12-1) 番目の面グループの 3 番目の面の情報 

*要素のタイプは  

 4 面体 1 次要素の場合は 4  

 4 面体 2 次要素の場合は 10  

 6 面体 1 次要素の場合は 8  

 6 面体 2 次要素の場合は 20 

 

**面の情報  

ここで、「面」とはメッシュ表面の 3 角形または 4 角形を意味しています。 最初の数字

が面の属する要素の番号を表し、次の数字が要素内の面番号を 表し、残りが面を構成する

節点の番号を表しています。  

面を構成する節点の数は  

 4 面体 1 次要素の場合 3 個  

 4 面体 2 次要素の場合 6 個  

 6 面体 1 次要素の場合 4 個  

 6 面体 2 次要素の場合 8 個  

です。 

節点の並びの順番は要素毎に以下のようになっています。 
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例えば、上記例の 1 番最後の行の  

15 1 49 50 53 52 

という行は、 この四角形が 15 番目の要素に属し、 要素内の面番号が 1 であり、4頂点が 

 
の 4 節点から構成されていることを表しています。  
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要素内の面番号と、面内の節点の並び順は、以下のように定義されています。  
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9.5. シングルボリューム用表面メッシュ抽出データファイル(拡張子 pch) 

リスト 9.5-1 シングルボリューム用表面メッシュ抽出データファイルのフォーマット(4

面体 1 次要素の場合) 

180   <- 節点の数  

2.5  -4.33013 0  <- 0 番目の節点の X, Y, Z 座標  

-2.5  -4.33013 0  <- 1 番目の節点の X, Y, Z 座標  

-5 0 0  

-2.5 4.33013 0  

2.5 4.33013 0  

...(省略) ...  

0.173913  -4.33013 9.48837  

0.560861  -4.33013 7.98095  

3.73934  -2.18354 9.54426  

4.24419  -1.30912 8.32609  

3.49047  -2.61458 7.93914 <-(180-1) 番目の節点の X, Y, Z 座標  

360   <- パッチの数  

99 117 116  <- 0 番目のパッチを構成する節点  

92 117 99   <- 1 番目のパッチを構成する節点* 

116 100 99  

92 99 118  

116 91 100  

...(省略) ...  

62 71 11  

63 71 62  

63 70 71  

63 18 70  

18 63 23   <-(360-1) 番目のパッチを構成する節点  

 

*パッチを構成する節点は、メッシュ表面の 1 次節点です。  

 4 面体 1 次要素の場合は 3 個の節点を記述  

 4 面体 2 次要素の場合は 3 個の節点を記述  

 6 面体 1 次要素の場合は 4 個の節点を記述  

 6 面体 2 次要素の場合は 4 個の節点を記述  

節点の番号はメッシュ表面の 1 次節点について振ったインデックスです。  

節点のコネクティビィティは形状の外から見て右周りです。  
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9.6. マルチボリューム用表面メッシュ抽出データファイル(拡張子 pcm) 

 

ここではマルチボリュームに対応した表面パッチファイルである*.pcm フォーマットに

ついて説明します。他のフォーマットからの変換の参考にして下さい。例えば以下の通り

になります。ボリューム境界の表現については、図 9.6-1 を参照してください。 

 

リスト 9.6-1 マルチボリューム用表面メッシュ抽出データファイルのフォーマット(4 面

体 1 次要素の場合) 

*pcm ver. 1.0  <- ファイルフォーマットのバージョン 

347 0 2  <- 頂点数 予備１ 領域数 

0.0 0.0 0.0  <- 0 番目の節点の X, Y, Z 座標  

1.0 9.0 88.0  <- 1 番目の節点の X, Y, Z 座標  

...(省略) ...  

84.05 34.6 98.1  <-(347-1) 番目の節点の X, Y, Z 座標  

5786 0 0   <- ボリューム 0 番目の表面パッチ数 予備 2 予備 3 

153 55 412  <- 0 番目のパッチを構成する節点  

567 45 34  <- 1 番目のパッチを構成する節点* 

...(省略) ...  

18 63 23   <-(5786-1) 番目のパッチを構成する節点  

456 0 0    <- ボリューム 1 番目の表面パッチ数 予備 2 予備 3 

99 42 765  <- 0 番目のパッチを構成する節点  

19 32 67   <- 1 番目のパッチを構成する節点* 

...(省略) ...  

99 23 21   <-(456-1) 番目のパッチを構成する節点  

 

予備１、予備２、予備３については予備項目です。（現在は全て０。） 

節点のコネクティビィティは形状の外から見て右周りです。  

 
図 9.6-1 表面パッチデータファイルのボリューム境界の表現 

 

  

ボリューム 0 番目の 

表面パッチ情報 

ボリューム 1 番目の 

表面パッチ情報 

1) ボリューム間の境界面上の頂点は２重頂点 

(ア) ボリューム１の頂点 → v0~v3 

(イ) ボリューム 2 の頂点 → v8~v11 

2) ボリューム間の境界面（３角形パッチ）

は、２重面 

(ア) ボリューム１の f0 → v0, v1, v2 

(イ) ボリューム２の f5 → v8, v9, v10 
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9.7. 表面パッチグループデータファイル(拡張子 pcg) 

リスト 9.7-1 表面パッチグループデータファイルのフォーマット 

#mainVertexInfo  

mainVertexN 144  <- メイン節点の数* 

0   <- 0 番目のメイン節点  

1   <- 1 番目のメイン節点  

2  

3  

4  

...(省略) ...  

157  

158  

159  

160  

161   <-(144-1) 番目のメイン節点  

 

#edgeGroupInfo  

edgeGroupN 168  <- エッジグループの数  

edgeGroup 2  <- 0 番目のエッジグループを構成する節点の数  

0   <- 0 番目のエッジグループの 0 番目の節点  

24   <- 0 番目のエッジグループの 1 番目の節点  

edgeGroup 2  <- 1 番目のエッジグループを構成する節点の数  

0   <- 1 番目のエッジグループの 0 番目の節点  

35   <- 1 番目のエッジグループの 1 番目の節点  

...(省略) ...  

edgeGroup 2  <-(168-1)番目のエッジグループを構成する節点の数  

99   <-(168-1) 番目のエッジグループの 0 番目の節点  

157   <-(168-1) 番目のエッジグループの 1 番目の節点  

#faceGroupInfo  

faceGroupN 28  <- 面グループの数  

faceGroup 24  <- 0 番目の面グループを構成するパッチの数  

0   <- 0 番目の面グループの 0 番目のパッチの番号  

1   <- 0 番目の面グループの 1 番目のパッチの番号  

...(省略) ...  

22   <- 0 番目の面グループの(24-2) 番目のパッチの番号  

23   <- 0 番目の面グループの(24-1) 番目のパッチの番号  

...(省略) ...  

faceGroup 6  <-(28-1)番目の面グループを構成するパッチの数  

354   <-(28-1) 番目の面グループの 0 番目のパッチの番号  

355   <-(28-1) 番目の面グループの 1 番目のパッチの番号  

356   <-(28-1) 番目の面グループの 2 番目のパッチの番号  

357   <-(28-1) 番目の面グループの 3 番目のパッチの番号  

358   <-(28-1) 番目の面グループの 4 番目のパッチの番号  

359   <-(28-1) 番目の面グループの 5 番目のパッチの番号 

*メイン節点とはモデルの形状を特徴づける代表的な節点です。 ADVENTURE_BCtool 

では、面グループの境界上の 1 次節点を メイン節点にしています。  
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9.8. グローバルインデックスファイル(拡張子 trn) 

リスト 9.8-1 グローバルインデックスファイルのフォーマット 

0  

1  

2  

行数はメッシュ表面の 1 次節点の数と同じ 3  

4  

...(省略) ...  

177  

178  

179 

*表面メッシュ抽出データファイル(拡張子 pch) での節点番号からメッシュデータファイ

ル(拡張子 msh) での節点番号への対応表です。  

*N 行目の数字は、表面メッシュ抽出データファイル(拡張子 pch) での節点番号 N−1 に

対応するメッシュデータファイル(拡張子 msh) の節点番号です。  

 

9.9. 物性値ファイル(拡張子 dat) 

指定できる物性値は表 9.9-2 に示す 11 種類です。  

表 9.9-2 指定できる物性値一覧 

物性値の名称 物性を示すラベル 備考 

ヤング率  YoungModulus   

ポアソン比  PoissonRatio   

加工硬化係数  HardeningParameter  弾塑性解析時に使用  

初期降伏応力  YieldStress  弾塑性解析時に使用  

質量密度  Density  自重負荷時に使用  

線膨張係数  ThermalExpansionCoefficient  熱応力解析時に使用  

参照温度  ReferenceTemperature  熱応力解析時に使用  

熱伝導率 HeatConductivity 熱解析時に使用 

比熱 SpecificHeat  熱解析時(非定常解析)に使用 

ステファンボルツマン係数 StefanBoltzmanConstant  熱解析時(熱ふく射解析時)に使用 

内部発熱 InternalHeatGeneration  熱解析時に使用 

 

全ボリュームに同一の物性を与える場合と、ボリュームごとに個別の物性を与える場合

でフォーマットが異なります。2種類のフォーマット(単一物性値、複数物性値) の判定はプ

ログラムが自動的に行います。 複数物性値のフォーマットでは、使用されない材料番号が

あってもかまいません。 複数材料(ボリュームが複数) のメッシュに対して、単一物性値の

フォーマットを使用すると、すべてのボリュームに同一の物性値を設定します。 単一材料

(ボリュームがひとつ)のメッシュに対して、複数物性値のフォーマットを 使用すると、ボ

リューム番号 0 の材料に対応した物性値を設定します。  

 

リスト 9.9-1 物性値ファイルのフォーマット(単一物性値の場合の記述例) 

YoungModulus 21000.0 <− ヤング率  

PoissonRatio 0.4  <− ポアソン比  

HardeningParameter 1000.0 <− 硬化係数  

YieldStress 500.0  <− 降伏応力  

Density 760.0  <− 密度 
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リスト 9.9-2 物性値ファイルのフォーマット(複数物性値の場合の記述例)  

#materialInfo  

materialN 2  <- 材料の数  

propertyN 2  <- 定義する物性値の数  

物性値を 2 つ定義 YoungModulus 21000.0  

材料を 2 つ定義 PoissonRatio 0.4  

YoungModulus 205940.0  

PoissonRatio 0.3  

#volumeInfo  

volumeN 3   <- ボリュームの数  

1   <- ボリューム番号 0 の材料番号  

0   <- ボリューム番号 1 の材料番号  

1   <- ボリューム番号 2 の材料番号 

 

9.10. 解析条件ファイル(拡張子 cnd) 

9.10.1. 境界条件が時間変化しない場合 

リスト 9.10-1 に境界条件が時間変化しない場合の解析条件ファイルのファイルフォーマッ

ト例を示し、各行の見方について境界条件の対象が節点の場合と面グループの場合に分け

て説明します。 

リスト 9.10-1 解析条件ファイルのファイルフォーマット 

gravity  

0 0 -9.8   <− 重力加速度の X,Y,Z 成分  

boundary 12  <− 境界条件のデータ数  

loadOnVertex 271 0 10.5 <− 節点 271 への荷重の X 成分が 10.5  

loadOnVertex 271 1 10.5 <− 節点 271 への荷重の Y 成分が 10.5  

loadOnVertex 271 2 10.5 <− 節点 271 への荷重の Z 成分が 10.5  

dispOnVertex 8 0 0  <− 節点 8 の X 方向の変位が 0  

dispOnVertex 8 1 0  <− 節点 8 の Y 方向の変位が 0  

dispOnVertex 8 2 0  <− 節点 8 の Z 方向の変位が 0  

tracOnFaceGroup 1 1 5.2 <− 面グループ 1 に垂直方向に強さ 5.2 の表面力  

tracOnFaceGroup 2 0 2 -1.1 <− 面グループ 2 に Z 方向の表面力が-1.1 

dispOnFaceGroup 3 0 0 0 <− 面グループ 3 の X 方向の変位が 0  

dispOnFaceGroup 3 0 1 0 <− 面グループ 3 の Y 方向の変位が 0  

dispOnFaceGroup 3 0 2 0 <− 面グループ 3 の Z 方向の変位が 0  

dispOnFaceGroup 4 1 1 <− 面グループ 4 の面に垂直な方向の変位が 1  

 

9.10.1.1. 節点に関する境界条件 

***OnVertex から始まる行が該当します (リスト  9.10-1 の場合 loadOnVertex と

dispOnVertex) 。***OnVertex の次に並んでいる 3 個の数字の意味は  

 1 個目 節点番号  

 2 個目  0:X 成分、1: Y 成分、2: Z 成分  

 3 個目  荷重または変位の大きさ  

となります。このフォーマットで記述される境界条件としては以下のものがあります。 

CND ラベル 境界条件の種類 

loadOnVertex nodeID 節点集中荷重 

dispOnVertex nodeID 節点変位 

accelOnVertex nodeID 節点加速度 

tempOnVertex nodeID 節点温度 

※温度は方向性を持たないため 2個目の数字は常に 0と記述される。 
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9.10.1.2. 面グループに関する境界条件 

***OnFaceGroup から始まる行が該当します(リスト 9.10-1 の場合 tracOnFaceGroup と

dispOnFaceGroup)。***OnFaceGroup の次に並んでいる数字の意味は、境界条件の方向

の指定方法が XYZ 軸方向か、面に対する法線方向かで 2 種類に分類され、さらに熱伝達・

熱ふく射に関して例外的な記述があります。 

・XYZ 軸方向で境界条件を指定した場合 

 1 個目 面グループ番号 

 2 個目 0 

 3 個目 0:X 成分、1: Y 成分、2: Z 成分 

 4 個目 荷重または変位の大きさ 

このフォーマットで記述される境界条件としては以下のものがあります。 

CND ラベル 境界条件の種類 

tracOnFaceGroup 面グループ表面力 

dispOnFaceGroup 面グループ変位 

velocOnFaceGroup 面グループ速度 

accelOnFaceGroup 面グループ加速度 

tempOnFaceGroup 面グループ温度 

※温度は方向性を持たないため 2 個目の数字は常

に 0と記述される。 

fluxOnFaceGroup 面グループ熱流束 

※熱流束は方向性を持たないため 2 個目の数字は

常に 0と記述される。 

 

・面に対する法線方向で境界条件を指定した場合 

 1 個目 面グループ番号 

 2 個目 1 

 3 個目 表面力または変位の大きさ 

このフォーマットで記述される境界条件としては以下のものがあります。 

CND ラベル 境界条件の種類 

presOnFaceGroup 面グループ圧力 

dispOnFaceGroup 面グループ変位 

velocOnFaceGroup 面グループ速度 

accelOnFaceGroup 面グループ加速度 

 

・面に対する熱伝達の場合 

 1 個目 面グループ番号 

 2 個目 外部接触温度 

 3 個目 熱伝達係数 

CND ラベル 境界条件の種類 

convOnFaceGroup 面グループ熱伝達 
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・面に対する熱ふく射の場合 

 1 個目 面グループ番号 

 2 個目 放射源の温度 

 3 個目 放射率 

 4 個目 形状係数 

CND ラベル 境界条件の種類 

radiOnFaceGroup 面グループ熱ふく射 

 

9.10.2. 境界条件が時間変化する場合 

9.10.1 で挙げられた境界条件を示す行の頭に、<Transient id>が加えられます。id は時

刻歴 ID を示します。時刻歴 ID は時刻歴ファイルの中で定義されています(9.11 参照)。 
例： 

Transient id loadOnVertex nodeID co value 節点 nodeID への co 軸方向荷重 
 

9.11. 時刻歴入力ファイル(拡張子 csv) 

ファイルフォーマットを以下に示します。複数入力ファイルを指定する場合、同じ時刻

歴 ID を持ったファイルが存在するとエラーが発生します。1 つのファイルに、複数の時刻

歴データを含めることができます。 

"ID",<時刻歴 ID> 

"Time","Load" 

<time0>,<load0> 

… 

 

["ID",<時刻歴 ID> 

"Time","Load" 

<time0>,<load0> 

…] 

 

9.12. MPC条件ファイル(拡張子 cnd) 

MPC条件を定義するファイルです。境界条件ファイルと拡張子が同じですので、混同し

ないよう気を付けてください。 

以下タイプ別に例を挙げて説明します。尚 MPC ID は MPC 条件の種類によらず一意と

します。なお、cndファイルで定義されたMPCは、一体型入力ファイルへの変換過程で節

点-節点間の MPC 条件に展開されるため、cnd 内の MPC ID は一体型入力ファイルには出

力されませんのでご注意ください。 

 

9.12.1. 剛体はり 

(1) 剛体はり I 

rbeamOnVertex 節点番号 MPCID 剛体はりタイプ 

 

例 

boundary 2 

rbeamOnVertex 3 0 1 

rbeamOnVertex 51 0 1 

ここで 

boundary:条件数を意味するラベル 

2:この例の MPC 条件数 

rbeamOnVertex:剛体はりを意味するラベル 

3 と 51: それぞれ pch 節点番号 

0: 節点 280 と 309 が共通の MPC ID 0 を使用していることから、これら 2 点が一つ
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の剛体はりを構成することが分かります。 

1: 剛体はりタイプ I のこと。 

 

(2) 剛体はり II 

rbeamOnVertex 節点番号 MPCID 剛体はりタイプ 

 

例:2 つの節点が一致しないことを前提とします 

boundary 2 

rbeamOnVertex 102 3 2  

rbeamOnVertex 87 3 2  

ここで 

boundary:条件数を意味するラベル 

2:この例の MPC 条件数 

rbeamOnVertex:剛体はりを意味するラベル 

102 と 87: それぞれ pch 節点番号 

3: 節点 102 と 87 が共通の MPC ID 3 を使用していることから、これら 2 点が一つ

の剛体はりを構成することが分かります。 

2: 剛体はりタイプ II のこと。 

 

(3) 剛体はり III 

rbeamOnVertex 節点番号 MPCID 剛体はりタイプ 

 

例 

boundary 2 

rbeamOnVertex 280 0 3 

rbeamOnVertex 309 0 3 

ここで 

boundary: 条件数を意味するラベル 

2:この例の MPC 条件数 

rbeamOnVertex: 剛体はりを意味するラベル 

280 と 309 それぞれ pch 節点番号 

0: 節点 280 と 309 が共通の MPC ID 0 を使用していることから、これら 2 点が一つ

の剛体はりを構成することが分かります。 

3: 剛体はりタイプ III のこと。 

 

(4) 剛体はり IV 

rbeamOnVertex 節点番号 MPCID 剛体はりタイプ 節点の所属する面番号 

 

例 

boundary 2 

rbeamOnVertex 102 3 4 5 

rbeamOnVertex 87 3 4 -1 

ここで 

boundary: 条件数を意味するラベル 

2:この例の MPC 条件数 

rbeamOnVertex: 剛体はりを意味するラベル 

102 と 87: それぞれ pch 節点番号 

3: 節点 102 と 87 が共通の MPC ID 3 を使用していることから、これら 2 点が一つ

の剛体はりを構成することが分かります。 
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4: 剛体はりタイプ IV のこと。 

5 と-1: 節点 102 と 87 それぞれの所属する面番号(節点に関わる法線ベクトルを

使用します。節点がエッジや頂点上にあるとき、節点は複数の面に所属します。どち

らの面に所属するかにより、法線ベクトルが異なるので、所属する面をユーザーに指

定させます。面は節点ペアのうち一つのみ指定すれば良いので、指定しない方は-1 と

して記述します)。 

 

(5) 剛体はり V 

rbeamOnVertex 節点番号 MPCID 剛体はりタイプ 0 

rbeamOnVertex 仮想節点番号 MPCID 剛体はりタイプ 1 x 座標 y 座標 z 座標 

 

例 

boundary 4 

rbeamOnVertex 3 4 5 0 

rbeamOnVertex 94 4 5 0 

rbeamOnVertex 162 4 5 0 

rbeamOnVertex 754 4 5 1 25.0 30.0 35.0 

 

ここで 

boundary: 条件数を意味するラベル 

4:この例の MPC 条件数 

rbeamOnVertex: 剛体はりを意味するラベル 

3 と 94 と 162: それぞれ pch 節点番号、3 点以上必要 

754: 仮想節点番号 

4: 節点番号 182、263、309 と 754 が共通の ID 4 を使用していることから、これら

4 点が一つの剛体はりを構成することが分かる。 

5: 剛体はりタイプ 5 のこと。 

0 または 1: 1ならば節点座標値データを持つ。0ならば持たない。仮想節点のみが座

標値を持つ。 

25.0: 仮想節点の x 座標 

30.0: 仮想節点の y 座標 

35.0: 仮想節点の z 座標 

 

9.12.2. 単純はり 

sbeamOnVertex 節点番号 1 節点番号 2 MPCID 単純はり荷重 

 

例 

boundary 2 

sbeamOnVertex 494 1 100.  

sbeamOnVertex 515 1 100.  

ここで 

boundary: 条件数を意味するラベル 

2:この例の MPC 条件数 

sbeamOnVertex: 単純はりを意味するラベル 

494 と 515: それぞれ節点番号 1 と節点番号 2 

1: 494 と 515 の 2 節点から構成される単純はりの MPCID 

100.: 単純はり荷重(正の数が引張りで、負の数が圧縮)荷重値が重複して記述

します。 
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9.12.3. 任意の点数のMPC 

lmpcOnVertex 節点番号 MPCID 軸 右辺有無 係数 右辺 

 

例 

boundary 6 

lmpcOnVertex 272 4 0 0 0.2  // 節点 272, MPCID 4, 軸 X, 右辺無(0), 係数 

lmpcOnVertex 272 4 1 0 0.8  // 節点 272, MPCID 4, 軸 Y, 右辺無(0), 係数 

lmpcOnVertex 272 4 2 1 -0.5 0.3  //節点 272, MPCID 4, 軸 Z, 右辺有(1), 係
数, 右辺 

lmpcOnVertex 564 2 0 0 -1  // 節点 564, MPCID 2, 軸 X, 右辺無(0), 係数 

lmpcOnVertex 564 2 1 0 1  // 節点 564, MPCID 2, 軸 Y, 右辺無(0), 係数 

lmpcOnVertex 564 2 2 0 0.4  // 節点 564, MPCID 2, 軸 Z, 右辺無(0), 係数 

ここで 

boundary: 条件数を意味するラベル 

6:この例の MPC 条件数 

lmpcOnVertex: Linear MPC を意味するラベル 

272,564: 節点番号 

4,2:  MPCID。MPCID=4 の例では右辺の値を持ちます。MPCID=2 の例では

右辺の値を持ちません。 

0,1,2:    軸を意味するフラグ。0 なら X 軸、1 なら Y

軸、2 なら Z 軸。 

0,1:    右辺を設定するかどうかのフラグ。1なら有、0なら無。 

0.2,0.8,-0.5,-1,1,0.4: MPC の係数 

0.3:    右辺の値。 

 

9.13. MPC記述ファイル(拡張子mpc) 

MPC 記述ファイルとは、MpcLocal2Global と MPC_assem2 の出力ファイルです。拡張

子は mpc ですが、内部は atx フォーマットに適合しています。 

 

9.13.1. 剛体はり I 

#自由度毎に 2 組の FEGA を用意する。また右辺値も MPCRHS で規定する。 

LinearConstraint 6 # 拘束条件行数 

3 0 0 1.  # msh 節点番号 1 x 軸 MPC ID u1 係数 

51 0 0 -1.  # msh 節点番号 2 x 軸 MPC ID u2 係数 

3 1 1 1.  #msh 節点番号 1 y 軸 MPC ID v1 係数 

51 1 1 -1.  #msh 節点番号 2 y 軸 MPC ID v2 係数 

3 2 2 1.  #msh 節点番号 1 z 軸 MPC ID w1 係数 

51 2 2 -1.  #msh 節点番号 2 z 軸 MPC ID w2 係数 

MPCRHS 3 # MPC 右辺条件総数 

0 0 0.0           # msh 節点番号(借) MPC ID 右辺の値 

1 1 0.0           # msh 節点番号(借) MPC ID 右辺の値 

2 2 0.0           # msh 節点番号(借) MPC ID 右辺の値 

 

説明 

LinearConstraint i 

LinearConstraint は MPC を意味するラベル、i は以下に続くデータ行数です。MPC ID

は複数の行にまたがって同一の ID を使うのが基本ですので、MPC ID の数と i とは一致し

ませんのでご注意ください。以下の各行は i4i4i4f8 でそれぞれ節点番号、自由度番号、

MPC ID と係数を記述します。i4 は 4 バイト整数、f8 は倍精度実数。 
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msh 節点番号 

pch上の節点番号ではないことに注意して下さい。trnデータを用いることで pch番号番

号(local 節点番号)から msh 節点番号(global 節点番号)へ変換されます。 

軸 

0,1,2 のいずれか。0 が X 軸、1 が Y 軸、2 が Z 軸を意味します。 

MPC ID 

MPC 条件を一意に定義するための ID。剛体はり I の場合、2 節点がこの ID で関係づけ

られます。 

係数 

各節点の各軸の変位成分に乗ずる係数です。 

MPCRHS 3 

MPC 右辺条件総数 

0 

msh 節点番号。この行のデータは実は節点番号 0 とは何の関係もありません。なんらか

の節点番号に付属するデータとして記述しなくてはいけないため、節点番号 0 を借用しま

した。以下のデータ行では節点番号を順に 1 ずつ増加させます(フォーマットの規則上は飛

び飛びでも構わないのですが、重複しないというのが趣旨です)。 

0 

この右辺値が関わる MPC ID です。LinearConstraint の MPC ID が 2 のデータととも

に、MPC 関係式を構成します。 

0.0 

MPC ID 2 の関係式の右辺の値。 

 

9.13.2. 剛体はり II 

LinearConstraint 6 # 拘束条件数 剛体はり II 

102 0 0 0.             # msh 節点番号 x 軸 MPC ID u1 の係数(x2 - x1) 

87 0 0 0.            # msh 節点番号 x 軸 MPC ID u2 の係数-(x2 - x1) 

102 1 0 0.             # msh 節点番号 y 軸 MPC ID v1 の係数(y2 - y1) 

87 1 0 0.            # msh 節点番号 y 軸 MPC ID v2 の係数-(y2 - y1) 

102 2 0 10.            # msh 節点番号 z 軸 MPC ID w1 の係数(z2 - z1) 

87 2 0 -10.          # msh 節点番号 z 軸 MPC ID w2 の係数-(z1 - z1) 

MPCRHS 1 # MPC 右辺条件総数 

0 0 100.    # msh 節点番号(借) MPC ID 右辺の値(x2 - x1) 2 +(y2 - y1) 2 

+(z2 - z1)2 

 

説明 

剛体はり IIのこの例では 102 と 87 の二つの節点についての一つの拘束条件を記述してい

ます。従って使用される MPC ID は 1 個です。各節点の 3 自由度が登場するので 6 行の

LinearConstraint データとなります。右辺が非ゼロです。 

 

9.13.3. 剛体はり III 

LinearConstraint 6 # 拘束条件数 

280 0 0 0.             # msh 節点番号 x 軸 MPC ID u1 の係数-(x2 - x1) 

309 0 0 0.            # msh 節点番号 x 軸 MPC ID u2 の係数(x2 - x1) 

280 1 0 0.             # msh 節点番号 y 軸 MPC ID v1 の係数-(y2 - y1) 

309 1 0 0.            # msh 節点番号 y 軸 MPC ID v2 の係数(y2 - y1) 

280 2 0 -10.           # msh 節点番号 z 軸 MPC ID w1 の係数-(z2 - z1) 

309 2 0 10.           # msh 節点番号 z 軸 MPC ID w2 の係数(z2 - z1) 

MPCRHS 1 # MPC 右辺条件総数 

0 0 0.    # msh 節点番号(借) MPC ID 右辺ゼロ 
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説明 

剛体はり III のこの例では 280 と 309 の二つの節点についての一つの拘束条件を記述し

ています。従って使用される MPC ID は 1 個です。各節点の 3 自由度が登場するので 6 行

の LinearConstraint データとなります。右辺がゼロです。 

 

9.13.4. 剛体はり IV 

LinearConstraint 6 # 拘束条件数  

102 0 7 -0.6           # msh 節点番号 x 軸 MPC ID u1 の係数-nx 

87 0 7 0.6             # msh 節点番号 x 軸 MPC ID u2 の係数+nx 

102 1 7 0.             # msh 節点番号 y 軸 MPC ID v1 の係数-ny 

87 1 7 0.              # msh 節点番号 y 軸 MPC ID v2 の係数+ny 

102 2 7 -0.8           # msh 節点番号 z 軸 MPC ID w1 の係数-nz 

87 2 7 0.8             # msh 節点番号 z 軸 MPC ID w2 の係数+nz 

MPCRHS 1 # MPC 右辺条件総数 

0 7 0.    # msh 節点番号(借) MPC ID 右辺ゼロ 

 

説明 

剛体はり IV のこの例では 102 と 87 の二つの節点についての一つの拘束条件を記述して

ます。従って使用される MPC ID は 1 個です。各節点の 3 自由度が登場するので 6 行の

LinearConstraint データとなります。右辺がゼロです。 

 

9.13.5. 剛体はり V 

LinearConstraint 57 # 拘束条件数 

#10.1.5 の関係式の x 成分を節点 i = 1 に適用 

3 0 0 0.03  # msh 節点番号 1 x 軸 MPC ID 係数 

3 1 0 -0.24  # msh 節点番号 1 y 軸 MPC ID 係数 

3 2 0 0.51  # msh 節点番号 1 z 軸 MPC ID 係数 

94 0 0 0.17  # msh 節点番号 2 x 軸 MPC ID 係数 

94 1 0 -0.36  # msh 節点番号 2 y 軸 MPC ID 係数 

162 0 0 0.48  # msh 節点番号 3 x 軸 MPC ID 係数 

#10.1.5 の関係式の y 成分を節点 i = 1 に適用 

3 0 1 0.09  # msh 節点番号 1 x 軸 MPC ID 係数 

3 1 1 -0.12  # msh 節点番号 1 y 軸 MPC ID 係数 

3 2 1 0.76  # msh 節点番号 1 z 軸 MPC ID 係数 

94 0 1 0.38  # msh 節点番号 2 x 軸 MPC ID 係数 

94 1 1 -0.17  # msh 節点番号 2 y 軸 MPC ID 係数 

162 0 1 0.84  # msh 節点番号 3 x 軸 MPC ID 係数 

#10.1.5 の関係式の z 成分を節点 i = 1 に適用 

3 0 2 0.01  # msh 節点番号 1 x 軸 MPC ID 係数 

3 1 2 -0.52  # msh 節点番号 1 y 軸 MPC ID 係数 

3 2 2 0.89  # msh 節点番号 1 z 軸 MPC ID 係数 

94 0 2 0.13  # msh 節点番号 2 x 軸 MPC ID 係数 

94 1 2 -0.92  # msh 節点番号 2 y 軸 MPC ID 係数 

162 0 2 0.76  # msh 節点番号 3 x 軸 MPC ID 係数 

#10.1.5 の関係式の x 成分を節点 i = 2 に適用 

3 0 3 0.02  # msh 節点番号 1 x 軸 MPC ID 係数 

3 1 3 0.28  # msh 節点番号 1 y 軸 MPC ID 係数 

3 2 3 -0.79  # msh 節点番号 1 z 軸 MPC ID 係数 

94 0 3 -0.11  # msh 節点番号 2 x 軸 MPC ID 係数 

94 1 3 -0.36  # msh 節点番号 2 y 軸 MPC ID 係数 

162 0 3 -0.54  # msh 節点番号 3 x 軸 MPC ID 係数 

#10.1.5 の関係式の y 成分を節点 i = 2 に適用 

3 0 4 -0.04  # msh 節点番号 1 x 軸 MPC ID 係数 



134 

 

3 1 4 0.57  # msh 節点番号 1 y 軸 MPC ID 係数 

3 2 4 -0.38  # msh 節点番号 1 z 軸 MPC ID 係数 

94 0 4 0.05  # msh 節点番号 2 x 軸 MPC ID 係数 

94 1 4 -0.17  # msh 節点番号 2 y 軸 MPC ID 係数 

162 0 4 -0.26  # msh 節点番号 3 x 軸 MPC ID 係数 

#10.1.5 の関係式の z 成分を節点 i = 2 に適用 

3 0 5 -0.13  # msh 節点番号 1 x 軸 MPC ID 係数 

3 1 5 0.66  # msh 節点番号 1 y 軸 MPC ID 係数 

3 2 5 -0.47  # msh 節点番号 1 z 軸 MPC ID 係数 

94 0 5 0.14  # msh 節点番号 2 x 軸 MPC ID 係数 

94 1 5 -0.26  # msh 節点番号 2 y 軸 MPC ID 係数 

94 2 5 0.38  # msh 節点番号 2 z 軸 MPC ID 係数 

162 0 5 -0.35  # msh 節点番号 3 x 軸 MPC ID 係数 

#10.1.5 の関係式の x 成分を節点 i = 3 に適用 

3 0 6 -0.41  # msh 節点番号 1 x 軸 MPC ID 係数 

3 1 6 0.09  # msh 節点番号 1 y 軸 MPC ID 係数 

3 2 6 -0.01  # msh 節点番号 1 z 軸 MPC ID 係数 

94 0 6 0.03  # msh 節点番号 2 x 軸 MPC ID 係数 

94 1 6 -0.77  # msh 節点番号 2 y 軸 MPC ID 係数 

162 0 6 0.78  # msh 節点番号 3 x 軸 MPC ID 係数 

# 10.1.5 の関係式の y 成分を節点 i = 3 に適用 

3 0 7 0.89  # msh 節点番号 1 x 軸 MPC ID 係数 

3 1 7 0.91  # msh 節点番号 1 y 軸 MPC ID 係数 

3 2 7 -0.12  # msh 節点番号 1 z 軸 MPC ID 係数 

94 0 7 -0.21  # msh 節点番号 2 x 軸 MPC ID 係数 

94 1 7 -0.42  # msh 節点番号 2 y 軸 MPC ID 係数 

162 0 7 0.13  # msh 節点番号 3 x 軸 MPC ID 係数 

162 1 7 0.39  # msh 節点番号 3 y 軸 MPC ID 係数 

#10.1.5 の関係式の z 成分を節点 i = 3 に適用 

3 0 8 -0.44  # msh 節点番号 1 x 軸 MPC ID 係数 

3 1 8 0.35  # msh 節点番号 1 y 軸 MPC ID 係数 

3 2 8 -0.04  # msh 節点番号 1 z 軸 MPC ID 係数 

94 0 8 -0.07  # msh 節点番号 2 x 軸 MPC ID 係数 

94 1 8 -0.92  # msh 節点番号 2 y 軸 MPC ID 係数 

162 0 8 0.43  # msh 節点番号 3 x 軸 MPC ID 係数 

162 2 8 0.61  # msh 節点番号 3 z 軸 MPC ID 係数 

MPCRHS 9 # MPC 右辺条件総数 

0 0 0.0           # msh 節点番号(借) MPC ID 右辺の値 

1 1 0.0           # msh 節点番号(借) MPC ID 右辺の値 

2 2 0.0           # msh 節点番号(借) MPC ID 右辺の値 

3 3 0.0           # msh 節点番号(借) MPC ID 右辺の値 

4 4 0.0           # msh 節点番号(借) MPC ID 右辺の値 

5 5 0.0           # msh 節点番号(借) MPC ID 右辺の値 

6 6 0.0           # msh 節点番号(借) MPC ID 右辺の値 

7 7 0.0           # msh 節点番号(借) MPC ID 右辺の値 

8 8 0.0           # msh 節点番号(借) MPC ID 右辺の値 

 

説明 

MPC ID 

MPC 条件を一意に定義するための ID。剛体はり Vの場合、3 個以上の節点がこの IDで

関係づけられます。上の例は拘束に使用する節点数が 3 個の場合です。 

0(MPCRHS 総数宣言の次の行の先頭) 

msh 節点番号。これは実は節点番号 0 とは何の関係もない。なんらかの節点番号に付属
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するデータとして記述しなくてはいけないため、節点番号 0 を借用した。以下順に 1 ずつ

増加させる。 

0(MPCRHS 総数宣言の次の行の二番目のデータ) 

この右辺値が関わる MPC ID である。LinearConstraint の MPC ID が 0 のデータとと

もに、MPC 関係式を構成する。 

0.0(MPCRHS 総数宣言の次の行の三番目のデータ) 

MPC ID 0 の関係式の右辺の値。ちなみに剛体はり V では常にゼロ。 

 

9.13.6. 単純はり 

節点番号 494 の P1(5., 7., 0.)、 節点番号 515 の P2(10., 7., 0. )、荷重値 100.、MPC ID=1

とすると、 

SimpleBeam 2 # 拘束条件数 

494 1 100.           # msh 節点番号 MPC ID 荷重代数値(正は引張、負は圧縮) 

515 1 100.            # msh 節点番号 MPC ID 荷重代数値(正は引張、負は圧縮) 

 

9.13.7. 一般的なMPC 

右辺の値以外は、LinearConstraint を使用して、記述します。 

右辺は MPCRHS というラベルの FEGA で記述します。節点番号毎に軸番号、MPC ID、

係数を指定します。ここで出てくる MPC ID は、cnd から変換する際に振りなおしたもの

で、cnd 内の ID とは無関係です。 

 
LinearConstraint 9 # 拘束条件数 任意の点数の MPC 

3 0 5 0.2             # msh 節点番号 x 軸 MPC ID u1 の係数 

3 1 5 0.8             # msh 節点番号 y 軸 MPC ID v1 の係数 

3 2 5 -0.5            # msh 節点番号 z 軸 MPC ID w1 の係数 

319 0 5 -1            # msh 節点番号 x 軸 MPC ID u2 の係数 

319 1 5 1             # msh 節点番号 y 軸 MPC ID v2 の係数 

319 2 5 0.4           # msh 節点番号 z 軸 MPC ID w2 の係数 

127 0 5 -1.2          # msh 節点番号 x 軸 MPC ID u3 の係数 

127 1 5 0.7           # msh 節点番号 y 軸 MPC ID v3 の係数 

127 2 5 0.1           # msh 節点番号 z 軸 MPC ID w3 の係数 

MPCRHS 1 # MPC 条件総数 

0 5 1.0           # msh 節点番号(借) MPC ID 9.3 の式の右辺 c の値 

 

なお MPCRHS と SimpleBeam には次行に次のデータが付随する場合があります。 

 
fega_type=NodeVariable  #節点に付随するデータタイプ 

format=i4f8          #データフォーマット。節点番号のフォーマットは略される。 

 

付随していない場合は a2adv によってこのデータが付加されます。 

 

9.14. 面グループペア設定ファイル(拡張子 cmb) 

MasterSlaveTool の入力となる、面グループペア設定ファイルです。 

 
4 # 面の組数 

3 8 # 1 組目のマスター面番号  スレーブ面番号 

4 9 # 2 組目のマスター面番号  スレーブ面番号 

6 10 # 3 組目のマスター面番号  スレーブ面番号 

7 12 # 4 組目のマスター面番号  スレーブ面番号 
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9.15. 節点ペアに関係したファイル(拡張子 np、nv) 

9.15.1. 節点ペアの出力フォーマット 

 
図5.1-1 節点ペアファイルフォーマット(拡張子 np) 

 

9.15.2. 節点ペアにおける法線ベクトルの出力フォーマット 

 
図 5.2-1 節点ペアにおける法線のファイルフォーマット(拡張子 nv) 

  

 31193 ← 節点ペアの数 

794 801256 ← 1 番目のペアの第 1 節点の ID，第 2 節点の ID  

795 801258 ← 2 番目のペアの第 1 節点の ID，第 2 節点の ID 

835 801259 

836 801260 

837 801261 

・・・・・・・ 

・・・・・・・ 

757503 1012239 ← 31193 番目のペアの第 1 節点の ID，第 2 節点の ID 

 31193 

0 0.047682 0.924802 -0.377448 ← 1 番目の節点ペア ID，法線ベクトル(xyz) 

0 -0.047912 -0.924919 0.377132 

1 0.047444 0.924918 -0.377194 

1 -0.047996 -0.925217 0.376391 

2 0.044090 0.925059 -0.377255 

2 -0.046319 -0.925042 0.377030 

・・・・・・・ 

・・・・・・・ 

節点ペアの数×2 行 
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10. Appendix D MPC条件の定義 
10.1. 剛体はり 

以下の項目中の式において、𝑝1⃗⃗⃗⃗ は一つのボリューム側のある節点 P1 の位置ベクトル、𝑢1⃗⃗⃗⃗ 

は P1 の変位ベクトル、𝑝2⃗⃗⃗⃗ は他方のボリューム側の別の節点 P2 の位置ベクトル、𝑢⃗ 2は P2の

変位ベクトルを意味します。また、𝑛⃗ はユーザーが指定した任意の面グループの法線ベク

トルを意味します。指定された面グループの法線ベクトルは、指定された面グループの各

三角形の法線ベクトルを規格化してから、各成分の平均値を取ることによって計算します。

各三角形の法線ベクトルは立体外向きとします。 

 

10.1.1. 剛体はり I 

2 点間の相対変位を全固定します。関係式は以下のように表されます。 

𝑢1⃗⃗⃗⃗ = 𝑢2⃗⃗⃗⃗  
 

10.1.2. 剛体はり II 

最初に離れている 2 点が接触するように変位させるため、2 点の相対変位ベクトルの、2

点が作るベクトル方向の成分を拘束します。両節点が同じ位置のときは、剛体はり II は定

義できません。関係式は以下のように表されます。 

(𝑝1⃗⃗⃗⃗ − 𝑝2⃗⃗⃗⃗ ) ∙ {(𝑝1⃗⃗⃗⃗ + 𝑢1⃗⃗⃗⃗ ) − (𝑝2⃗⃗⃗⃗ + 𝑢2⃗⃗⃗⃗ )} = 0 

 

10.1.3. 剛体はり III 

2 節点間の距離が等しくなるように拘束します。関係式は以下のように表されます。 

(𝑝2⃗⃗⃗⃗ − 𝑝1⃗⃗⃗⃗ ) ∙ (𝑢2⃗⃗⃗⃗ − 𝑢1⃗⃗⃗⃗ ) = 0 

 

10.1.4. 剛体はり IV 

節点間の相対変位のうちユーザーが指定した任意の面グループの法線方向の変位のみを

拘束します。関係式は以下のように表されます。 

𝑛⃗ ∙ 𝑢1⃗⃗⃗⃗ = 𝑛⃗ ∙ 𝑢2⃗⃗⃗⃗  
⇔ 𝑛⃗ ∙ (𝑢2⃗⃗⃗⃗ − 𝑢⃗ 1) = 0 

 

10.1.5. 剛体はり V  

ユーザーが指定した仮想節点と、既存の一直線上にない 3 点以上の点を剛体接続するこ

とにより、これら 4 点の剛体モードをなくすように拘束します。𝑝1⃗⃗⃗⃗ の成分を(𝑥1, 𝑦1, 𝑧1)、𝑝2⃗⃗⃗⃗ 

の成分を(𝑥2, 𝑦2, 𝑧2)、3点目の位置ベクトル𝑝3⃗⃗⃗⃗ の成分を(𝑥3, 𝑦3, 𝑧3)とおくと、関係式は以下の

ように表されます。 

𝑢 = 𝑖 [

1 0 0 0 − 𝑙𝑧𝑖 𝑙𝑧𝑖

0 1 0 𝑙𝑧𝑖 0 − 𝑙𝑧𝑖

0 0 1 − 𝑙𝑧𝑖 𝑙𝑧𝑖 0

]𝐵

[
 
 
 
 
 
 
 𝑢𝑥1

𝑢𝑦1

𝑢𝑧1

𝑢𝑥2

𝑢𝑦2

𝑢𝑧2 ]
 
 
 
 
 
 
 

 

ただし 

(𝑥1, 𝑦1) ≈ (𝑥2, 𝑦2)かつ𝑦2 ≈ 𝑦3のとき、 𝑢𝑧3 の代わりに 𝑢𝑦3  

(𝑥1, 𝑦1) ≈ (𝑥2, 𝑦2)かつ𝑦2 ≈ 𝑦3でないとき、 𝑢𝑧3 の代わりに 𝑢𝑥3  

となります。 

ここで 

𝑢𝑖 は一般の節点(仮想節点以外の節点)𝑖における変位ベクトル、 
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また、𝑥́を仮想節点の位置ベクトル、 𝑥𝑖 を一般の節点の位置ベクトルとしたとき 

𝑙 = 𝑥́𝑖 − 𝑥𝑖  

𝐵 = 𝐴−1 

𝐴 =

[
 
 
 
 
 
 
 1 0 0 0 − 𝑙𝑧1 𝑙𝑦1

0 1 0 𝑙𝑧1 0 − 𝑙𝑥1

0 0 1 − 𝑙𝑦1 𝑙𝑥1 0

1 0 0 0 − 𝑙𝑧2 𝑙𝑦2

0 1 0 𝑙𝑧2 0 − 𝑙𝑥2

0 0 1 − 𝑙𝑦3 𝑙𝑥3 0 ]
 
 
 
 
 
 
 

 

です。 

ただし 

(𝑥1, 𝑦1) ≈ (𝑥2, 𝑦2)かつ𝑦2 ≈ 𝑦3のとき、 

𝐴 =

[
 
 
 
 
 
 
 1 0 0 0 − 𝑙𝑧1 𝑙𝑦1

0 1 0 𝑙𝑧1 0 − 𝑙𝑥1

0 0 1 − 𝑙𝑦1 𝑙𝑥1 0

1 0 0 0 − 𝑙𝑧2 𝑙𝑦2

0 1 0 𝑙𝑧2 0 − 𝑙𝑥2

0 1 0 𝑙𝑦3 0 − 𝑙𝑥2 ]
 
 
 
 
 
 
 

 

(𝑥1, 𝑦1) ≈ (𝑥2, 𝑦2)かつ𝑦2 ≈ 𝑦3でないとき、 

𝐴 =

[
 
 
 
 
 
 
 1 0 0 0 − 𝑙𝑧1 𝑙𝑦1

0 1 0 𝑙𝑧1 0 − 𝑙𝑥1

0 0 1 − 𝑙𝑦1 𝑙𝑥1 0

1 0 0 0 − 𝑙𝑧2 𝑙𝑦2

0 1 0 𝑙𝑧2 0 − 𝑙𝑥2

1 0 0 0 − 𝑙𝑧3 𝑙𝑦3 ]
 
 
 
 
 
 
 

 

となります。 

 

10.2. 単純はり 

単純はりは 2 点間に強制的な内力を与えるようなときに使用します。関係式は以下のと

おりです。 

𝐿1
⃗⃗⃗⃗ = 𝐿

𝑝2⃗⃗⃗⃗ − 𝑝1⃗⃗⃗⃗ 

|𝑝2⃗⃗⃗⃗ − 𝑝1⃗⃗⃗⃗ |
 

𝐿2
⃗⃗⃗⃗ = 𝐿

𝑝1⃗⃗⃗⃗ − 𝑝2⃗⃗⃗⃗ 

|𝑝1⃗⃗⃗⃗ − 𝑝2⃗⃗⃗⃗ |
 

 

ここで、𝐿1
⃗⃗⃗⃗ は P1 に負荷する荷重ベクトル、𝐿2

⃗⃗⃗⃗ は P2に負荷する荷重ベクトルです。𝐿は荷

重の大きさですが、引張で正の数、圧縮で負の数とします。 

各成分で表現しますと 

𝐿2𝑥 =
𝐿(𝑥2 − 𝑥1)

√(𝑥2 − 𝑥1)2+(𝑦2 − 𝑦1)2+(𝑧2 − 𝑧1)2
 

𝐿2𝑦 =
𝐿(𝑦2 − 𝑦1)

√(𝑥2 − 𝑥1)2+(𝑦2 − 𝑦1)2+(𝑧2 − 𝑧1)2
 

𝐿2𝑧 =
𝐿(𝑧2 − 𝑧1)

√(𝑥2 − 𝑥1)2+(𝑦2 − 𝑦1)2+(𝑧2 − 𝑧1)2
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𝐿1𝑥 =
𝐿(𝑥1 − 𝑥2)

√(𝑥2 − 𝑥1)
2+(𝑦2 − 𝑦1)

2+(𝑧2 − 𝑧1)
2
 

𝐿1𝑦 =
𝐿(𝑦1 − 𝑦2)

√(𝑥2 − 𝑥1)
2+(𝑦2 − 𝑦1)

2+(𝑧2 − 𝑧1)
2
 

𝐿1𝑧 =
𝐿(𝑧1 − 𝑧2)

√(𝑥2 − 𝑥1)
2+(𝑦2 − 𝑦1)

2+(𝑧2 − 𝑧1)
2
 

 

ここで(𝐿1𝑥 , 𝐿1𝑦 , 𝐿1𝑧)と(𝐿2𝑥, 𝐿2𝑦, 𝐿2𝑧)はそれぞれ節点 P1 と P2 における荷重ベクトルの成分

です。 

 

 

10.3. 任意の数の節点に対する一般的な MPC 

関係式は 

𝑓𝑥𝑖𝑢𝑖 + ∑𝑓𝑦𝑖𝑣𝑖 + ∑𝑓𝑧𝑖𝑤𝑖

𝑛

𝑖=1

𝑛

𝑖=1

= 𝑐

∑

𝑛

𝑖=1

 

ここで、𝑛は一般的 MPC 条件を持つ節点個数。𝑖は𝑛個のうちの𝑖番目。𝑓𝑥𝑖、𝑓𝑦𝑖、及び𝑓𝑧𝑖
はそ れぞれ𝑖番目の節点の𝑥、𝑦、及び𝑧方向変位にかかる係数です。𝑐は一次関係式の定数

値です。 
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